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About this course Objectives of the course Upon completion of this course, you will be able to: - Modify CATIA options in order to optimize performance for large, complex designs - Manage contextual links between product documents by using publications - Create and use parameters to drive a product design - Create sections to visualize internal product structure - Create scenes and exploded views - Generate annotations and bills of material for assembly drawings



Targeted audience Mechanical Designers
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Students attending this course should have the knowledge of CATIA Product Design, CATIA Part Design
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Introduction to Working with Large Assemblies
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Table of Contents (3/3) Hiding Components Deactivating Representations Deactivating a Component Selective Load Using Visualization Mode Summary of Modes Recap Exercise : Washing Machine To Sum Up
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Analyzing Assemblies to Prepare drawing



Instructor Notes:
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Introduction to Product Design Expert (1/2)
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In the Product Design course, you have learned how to assemble the components into a Product.
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Introduction to Product Design Expert (2/2) In the Product Design Expert course, you will learn how to improve your assemblies in a progressive approach: Analyze the links between the components of a Product. Create the different components of the product with associative design using publication. Make some sub-assemblies flexible. Manage the representations of the product in order to improve the display performances of large assemblies.



Copyright DASSAULT SYSTEMES



Analyze the product and prepare its drawing.
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Managing a Product Structure In this lesson, you will learn how to manage product structure of assembly documents.
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Introduction to Managing a Product Structure Managing Links Between Components Generate CATPart from CATProduct Recap Exercise: Bicycle Assembly To Sum Up
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Introduction to Managing a Product Structure (1/2) You can manage a product structure of an assembly document using File > Desk or Edit > Links command. You can load / unload, activate / deactivate, replace , find documents using File > Desk or Edit > Links command.
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Structure of Linked documents using File > Desk.



Links of selected component using Edit > Links.
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Introduction to Managing a Product Structure (2/2)
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You can suppress the product design details by generating a single CATPart from a CATProduct using Tools > Generate CATPart from Product .
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Managing Links Between Components
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You will learn how to manage links between Components of a product.
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What are Links Between Components in a Product? In an assembly document, "Links" are maintained between all related CATProducts, CATParts, cgr files and documents (.txt and .xls files) which are referred by Design tables, etc. These links can be seen from Edit > Links Menu or by using File > Desk command.
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Edit Links Window displays linked documents



File > Desk command displays a graph showing linked documents



Instructor Notes:
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Why Manage Links? Using Edit Links and File Desk command, you can perform a number of tasks related to managing the product structure of a product.
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Using Edit Links, it is possible to : Quickly analyze the broken links. Load / Unload individual components. Activate / Deactivate components. Isolate components. Replace components.



Using File Desk, it is possible to : Visualize structure of linked components. Load / Unload individual components. See the links of CATProduct. View the properties of component. Find missing components and re establish links .



Instructor Notes:
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Accessing File Desk Command You will see how to access File Desk command. Open a CATProduct and Click on File > Desk. A new window displays a tree with CATProduct at the root and its child documents. These documents are CATParts, CATProducts, V4 models, other documents such as Text files and Excel documents.



Root Product Child Documents



Other linked documents



The colors used to identify the various document types are the following ones: Copyright DASSAULT SYSTEMES



White for loaded documents Black for documents that are not loaded in the current session Red for documents that have not been found.



Instructor Notes:



Make a demo with a CATProduct with various states of sub documents (loaded, unloaded, missing)
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Managing Links of a Product Using File Desk (1/2) You will learn how to use File Desk command to manage component links. To access contextual menu, right click on a desired component in the tree. Using contextual menu, you can load / unload documents, search for missing components, view the properties and view links.
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When an unloaded document points to other documents, the pointed documents are also unloaded. When unloading a part that belongs to several products, the Unload command applies to all the instances of the part. You can also use the Desk File Management toolbar to move, rename and delete documents. Renaming a file does not rename the part in specification tree.



Instructor Notes:
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Managing Links of a Product Using File Desk (2/2)



When you open a document of which one or more links are invalid, the Open dialog box appears along with the document opened and a broken link icon appears in the specification tree.
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Click on Desk to launch the File Desk command. From contextual menu of Red colored document, click on Find. This command launches a file browser to search and select the missing document. Selecting a missing document restores the broken link.



The specification tree will be updated as a result of loading or unloading of document and finding the missing document.



Instructor Notes:
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Accessing Edit Links Command You will see how to access Links command.
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Active Document is Moving Parts. Click on Edit > Links, to see the linked documents of this selected component



Instructor Notes:



Make a demo with 2 CATParts with some geometry imported from one file to the other. The link will enable to retrieve the original from the copied element with link.
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Managing Links of a Product Using Edit Links (1/2) Using Edit Links, you can restore broken links of a selected component. When you open a document and one or more of its links are invalid, a broken link icon appears in the specification tree.
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Using Edit Links, you can see the status for the missing document as “Document not found”. Click on Pointed Documents tab.



Instructor Notes:
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Select the document which is not found, and click on Find button to launch the file browser which will allow you to select the missing document.



Product Design



Managing Links of a Product Using Edit Links (2/2) You can Activate / Deactivate a component from Links window. Deactivating a component will suppress the synchronization of linked elements during part update.
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You can synchronize the links in the components using Synchronize command.



You can Load the document which is not loaded from the Pointed documents tab, by clicking on the Load button. You can also Replace the document with another one.



Instructor Notes:
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Generate CATPart from product You will see how to generate a CATPart from a CATProduct
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CATProduct



Instructor Notes:
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CATPart
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What is Generating a CATPart from a product ?
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This functionality creates a non associative result.



Benefits: - Band width requirement reduction - Single part is seen as such in the BOM - IP Protection: no view on internal design



Instructor Notes:
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Generating a CATPart from a product (1/2) Using “Generate CATPart from Product” menu under Tools menu, you can generate a singe CATPart from a CATProduct. Click on Tools > Generate CATPart from Product menu
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1



Instructor Notes:
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2



Select the root product, edit a new part number. Select the Merge all bodies in each Part in one Body option.



3



Click on OK.
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Generating a CATPart from a product (2/2)
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4



A new CATPart is generated from CATProduct.



Check that the hidden component in the original CATProduct does not appear in the Final Part.



Instructor Notes:
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Components are renamed with the path of instance in reference product
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Bicycle Assembly Recap Exercise: Managing Product Structure 15 min



In this exercise, you will add the missing document in the Bicycle assembly. You will modify the design of one of its components and generate a single CATPart for review and analysis. In this process, you will use following functions in Assembly Design Workbench:
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Desk Command Edit > Links Generate CATPart from Product



Instructor Notes:
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To Sum Up In this lesson you have learned how to :
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Manage Links between the components of a Product using File Desk and Edit Links command. You can Activate / Deactivate component , Load/Unload component, Synchronize links, Replace documents, Find missing documents.



Generate a CATPart from a CATProduct. You can suppress all the design details of an assembly document and reduce the document size of the component by converting a CATProduct to CATPart.



Instructor Notes:
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Designing and Managing Contextual Parts
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Designing Managing Contextual Parts



Introduction to Design in Context Creating Contextual Parts Sketch and Design in Context Knowledgeware and Design in Context Editing Contextually-related Parts Creating Assembly Features Isolating Contextual Parts Analyzing Contextual Parts Deleting Contextually-related Components Saving Contextually-related Documents Recap Exercise: Earphone To Sum Up
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Introduction to Design in Context
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You will learn what is design in context and its usefulness.



Instructor Notes:
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What is Designing Contextual Parts?
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An assembly is a CATProduct document containing components such as CATParts, CATProducts, V4 Models and Models from external source ( IGES, STEP, VRML). The individual parts are positioned relative to each other and are constrained using assembly constraints. Assembly design also allows you to design parts contextually. In a CATProduct document you can create associative links between several parts. These links can be geometrical and are then referred to as “External references“ or parametrical and then are referred to as “External parameters” in the specification tree. A part is contextually designed if a part is using an external parameter or an external reference element for its definition.



Instructor Notes:
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Contextual Part using External Parameters When a part refers to the parameters defined in another part, a contextual part using External Parameters is designed.
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Pin support is designed contextually. The inside diameter of support uses radius of pin as a reference parameter.



Instructor Notes:
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When pin diameter is changed, Pin support inside diameter needs to be updated, hence the part becomes red.



After updating an assembly, pin support inside diameter gets updated.
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Contextual Part using External References When a part refers to the geometrical elements in another part, a contextual part using External Reference Elements is designed.
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In the Base part, holes defined in the pin support are used to define the sketch for the pad.



Instructor Notes:
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If the hole diameter changes, hole diameter of Base needs update, hence the part becomes red.



After updating an assembly, hole diameter in base part gets updated.
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Contextual Parts using Assembly Features A contextual link is also created when Assembly Remove feature is created using an existing part.
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In this example, pin is used to create an Assembly Remove feature in the two Pin Supports and Housing.



Instructor Notes:
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Any changes in Pin like diameter or shape will affect the Hole dimensions in the Housing and Pin Supports.
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Creating Contextual Parts
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You will learn how to design parts that are contextual, or geometrically driven by other components.



Instructor Notes:
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What are Contextual Parts? Contextual parts are parts having geometry driven by other components. Changing geometry in another component can automatically cause changes to a contextual part.



Rounded edge and Hole of insert are contextually concentric with the pin in the green component. The sketch of the rounded edge and hole are explicitly constrained to be concentric with the pin. Insert Housing



The width of the highlighted “rib” is contextually controlled by the edges of the “slot” in the green component. The sketch of the brown “rib” was projected from the edges of the “slot”.
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The depth of the “rib” is contextually controlled by the depth of the “slot”. The depth of the “rib” is defined as up-to-plane of the slot bottom. The bottom face of the insert contextually rests on the top face of the green component. The insert sketch has green face as sketch support.



Instructor Notes:
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Why to use Design in Context? Designing in Context helps Concurrent Engineering Design. It has following benefits: Reuse existing Geometry : In order to facilitate design, you can reuse any geometrical element defined in other part to define a contextual part. For instance, you can reuse an existing sketch in another part instead of recreating it. You can also reuse geometrical entity (point, line, curve, plane or a surface). Reuse Parameters: You can reuse parameters defined in one part to define a contextual part. Automatic Update of assembly in case of changes in design : When designing in context, the
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contextual part is automatically updated when the geometry of the referenced part changes. You don’t have to edit the contextual part to change its design.



Instructor Notes:
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Examples Of Contextual Parts in Action (1/2) Here are some examples of how contextual parts can be driven by changes to other parts.



Here the width of the slot has been changed. Notice how the width of the “rib” is driven by the edges of the slot.
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Here the depth of the slot has been changed. Notice how the depth of the “rib” is driven by the depth of the slot.
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Examples Of Contextual Parts in Action (2/2) Here are some examples of how contextual parts can be driven by changes to other parts.
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Here the location of the pin has been changed. Notice how the location of the hole is driven by the location of the pin.
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Contextual Parts in the Tree The tree indicates whether a part is contextual and therefore has External References to other components. The green gear signifies the “original” instance of a part that is contextual (driven by another part). The brown gear signifies the second or subsequent instance of a part that is contextual. It identifies a part out of is context.



The white gear signifies the “original” instance of a part defined in context of an intermediate document.
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External geometry is copied from driving parts to contextual parts that are being driven. The copies are organized in the External References branch of the part.



Instructor Notes:
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Creating Contextual Elements Contextual elements can be created while designing sketches and features in-context. Turn ON the option Keep Link with Selected Object



3



Project edges of the slot onto the sketch plane and complete the sketch. Constrain sketch elements to edges of other components.
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1



Instructor Notes:
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Click on Sketcher icon and select the face of green component to link the sketched face with this component.



2



4



Create a pad using this sketch and limit it upto the groove depth. This pad is now contextually designed.



External geometry is copied from driving parts to contextual parts that are being driven. The copies are organized in the External References branch of the part.
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Constraining Contextual Instances Of Parts (1/2) Assembly constraints are forbidden when there is a potential conflict between geometric and assembly constraints. Assembly constraints are always forbidden when any element in a sketch is associative. Housing



Here the Housing component is sketched on a plane defined in Base Plate component. Also the sketch is constrained using the edges of the Base Plate component. The pad’s sketch has external links to the Base Plate.



Base Plate



Case 1 : Geometrical Constraints and Assembly Constraints in conflict : The offset constraint is forbidden because it would cause a potential conflict between the sketch and assembly constraint .
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Attempt to define an assembly offset constraint between highlighted faces leads to the following warning message.



Instructor Notes:
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Constraining Contextual Instances Of Parts (2/2) Case 2 : Geometrical Constraints and Assembly Constraints are not in conflict Housing Here the sketch of the Shaft is designed using face of the housing part. The Shaft has external link to the Housing part.



Shaft



Here shaft is NOT concentric with respect to the Housing pocket.
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An Assembly Coincidence constraint is permitted between the axis of Shaft and the axis of Housing part as there is NO conflict between the geometrical and assembly constraint.



Shaft and Housing are concentric now.



Defining an assembly coincidence constraint



Instructor Notes:
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Constraining Non-Contextual Instances Of Parts Assembly constraints can be used when there is no conflict between assembly and geometry constraints. Non contextual parts can be constrained using assembly constraints as these parts.



RightInsert



RightInsert is a copy of Insert part. It is a Non Contextual Instance and not designed in context. It can be positioned using assembly constraints because no geometric elements of the part were contextually defined within this instance of the part.



Housing
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LeftInsert While constraining contextual parts, you cannot use geometrical elements that have external references to other parts as parents (immediate or not). You can use geometrical elements that have no link with external geometry or parameter. These geometrical elements can be for instance: xy, zx and zy planes, a point build with coordinates, a line defined with an angle from Z axis, etc.



Instructor Notes:
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Assembly constraints applied to Non-Contextual Instance
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Sketch and Design in Context
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You will learn how to use sketches of other parts in the assembly to design parts in context .



Instructor Notes:
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What is using Sketch in Context ? It is possible to reuse a sketch created in one part to define another part. It means that the two parts share the same sketch. If sketch in the original instance is modified, the geometry of contextual part is also modified.
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In this example, the pad of the Fixture Cover reuses a sketch.1 of Housing part. Hence Fixture Cover is contextually linked to Housing part.



An external reference is created to the Sketch.1



Instructor Notes:
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Why Using Sketch in Context ?
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It can be much more useful to select same sketch to define two different parts than using projections of edges of one part to define the other .



In the first case, edges are projected from green part into the sketch of the other. A lot of external references are created which need to synchronized everytime when sketch changes.



Instructor Notes:
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In the second case, the sketch of Housing part is directly used to create the pad of the Fixture Cover.Now there is only one external reference to synchronize. Hence updation is faster.
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Using a Sketch As an External Reference (1/2) Simply use the sketch of another part to design the new part and take care to keep link with selected object. 5 Define the pad first limit as top surface 1 Edit the Part in which you want to and second limit as shown. Click on create a pad or another Sketch Based feature.



2



Reverse direction.



Click on Pad icon.



3



Select Sketch in another part as profile
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6



4



Click on “Yes” to confirm your choice.



Instructor Notes:
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Click on OK.



Product Design



Using a Sketch As an External Reference (2/2)



7



Activate the root assembly and try to move the newly created component



8



Click on Update.



Copyright DASSAULT SYSTEMES



9



Reference planes of “FixtureCover”



Instructor Notes:
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You will see that position of the component relative to the original sketch impacts its geometry



Relative positions of Pad (linked to the external reference“Sketch1”) and reference planes of the part have changed. “Sketch1” remain an exact copy of “MasterSketch”.
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Knowledgeware and Design in Context
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You will learn how to use parameters of other parts in the assembly to design parts in context .



Instructor Notes:
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Why to use Parameters in Context ? During assembly design, you can have parameters of a part driven by parameters of another part of the assembly or by parameters of the assembly itself .
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In this case, we would like this parameter concerning FixtureCoverForKWE component to be equal to …



Instructor Notes:
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…this other parameter concerning Holder component which himself could be equal to…



…this user parameter of the root assembly
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Linking Parameters Of Two Parts in the Assembly (1/3) Creating a relation involving parameter of another part is possible, a linked copy of this parameter will be created under External Parameter node. Edit the part on which you want to create a relation.



3



Click on “Add formula”.
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1



Instructor Notes:
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2



Select Formula icon . Formula editor panel is opened. Select the parameter you want to drive.



4



Editing the formula, First select the other part in geometry so CATIA will know that you want to select a parameter outside the active part.
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Linking Parameters Of Two Parts in the Assembly (2/3)



The External parameter selection box has appeared.



6



7



Select driving parameter.



8
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5



Instructor Notes:
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Click on a feature of the selected part to focus parameters filter on it and make the parameters appear in 3D.



The parameter is selected in the dialog box. Click OK to confirm.
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Linking Parameters Of Two Parts in the Assembly (3/3)



9



Click OK to confirm Parameter edition.



10



Here is the result



Component still has a yellow wheel indicating it is not contextual to the assembly.



A parameter Length has appeared under External Parameter node.
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11



Parent and Children box of the External Parameter «Length» displays the link to the parameter and indicates its owner document.



Instructor Notes:
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Created formula is under Relations node.
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Using a Parameter Of the Assembly to Design a Part (1/3) You can also drive a parameter of a Part of the Assembly with a parameter of the Assembly itself. 1



Edit the Part in which you want to create a relation



2



Click on Formula icon



Select the parameter you want to be driven



3



4
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5a



First select the root node of the assembly so CATIA will know you want to select a parameter outside the 5 active part Editing the formula, select a Parameter in the root assembly



Instructor Notes:
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Click on
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Using a Parameter Of the Assembly to Design a Part (2/3)



The External parameter selection box has appeared
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5b



Instructor Notes:
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5c Select driving parameter



5d Validate the External Parameter selection



6



7



Validate the formula



Validate the Parameter edition
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Using a Parameter Of the Assembly to Design a Part (3/3) The component using an external parameter in the assembly becomes contextual. 8



Here is the result The component still have a yellow wheel indicating it is not contextual to the assembly



A parameter with green light (indicating synchronization with external document) has appeared under External Parameters node



Created formula is under Relations node
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Instructor Notes:
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Parent and Children box of «FittinHeight» parameter displays the link to the external Parameter and indicates its owner document
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Editing Contextually-related Parts
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You will learn how to edit contextual parts



Instructor Notes:
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What Is Editing Contextually-related Parts ? With regard to editing parts, there are two notions to consider: editing contextual parts that have external references and are therefore driven; and editing parts that drive contextual parts.
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Editing Driven Part



Here we are editing a contextual part that has External References and is therefore driven by geometry in other components.



Instructor Notes:
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Editing Driving Part



Here we are editing a part that drives geometry in other parts that are contextual.
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What Is Editing Driving Parts ? Editing a part that drives other contextual parts will cause changes to geometry in the other parts. Housing (Driving Part) In this example Housing is a Driving Part. It drives the geometry of Insert Part.



Insert (Driven Part)
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Housing (Driving Part)



Here the width of the slot in the green part has been changed. The width of the “rib” of the insert is driven by the edges of the slot.



Instructor Notes:
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What Is Editing Contextual Parts ? Parts that are contextual (driven) by other components can be edited within or outside the context of the assembly in which the contextual elements were defined.



Copyright DASSAULT SYSTEMES



You can edit the “original” instance of a contextual part because often many of the contextual elements were probably defined here.



Instructor Notes:
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However, you can also edit a contextual part via instances of the part that are not the “original” instance. This can be useful when defining new contextual elements that are dependant on the position of an instance that is not the “original” instance.



You can also edit contextual parts without opening the assembly, but contextual elements cannot be completely updated because the context (assembly and components) in which the contextual elements were defined is not available.
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Editing Driving Parts After editing driving parts you will have to update contextual (driven) parts in-context of the assembly. Double-click the driving part to be edited



2



3



Exit the sketcher and Activate the Root Product.



4
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1



Instructor Notes:
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Edit the driving part – Change the pad offset distance to 18 mm.



Update the assembly to update the contextual part.



You can edit driving parts outside the context of the assembly, but the assembly must be opened to fully update contextual parts because contextual elements can be updated only in the context in which they were defined.
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Automatically Synchronizing Changes when Editing Driving Parts You can set an option to synchronize all contextual elements when simply pressing Update. 1



Turn ON the option Synchronize All External References for Update



All contextual elements in driven parts are synchronized with driving parts by simply pressing Update.



Edit the driving part. The location of pad in Housing is changed.
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Instructor Notes:
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3



Update contextual parts that are driven by the edited part.
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Manually Synchronizing Changes when Editing Contextual Parts (1/2) You can set an option to synchronize individual contextual elements. Turn OFF the option Synchronize All External References for Update



3



Right-click the feature to be updated in the contextual part and select Parent/Children…
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Instructor Notes:
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2



Edit the driving part.



4



Right-click the node of interest and select Show All Parents to see External References.
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Manually Synchronizing Changes when Editing Contextual Parts (2/2) 5



Right-click the node of interest in the specification tree and from selected Object Menu, click on Synchronize.
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6



All parents of Surface.2 are displayed in the Parents and Children window.



Instructor Notes:
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Editing Contextual Parts When editing contextual parts pay close attention to the creation and edition of contextual elements. 1



To edit or create non-contextual elements, doubleclick any instance of the part



2



Edit the part



You can also make non-contextual changes by opening only the CATPart.



To edit or create a contextual element, double-click the instance of the part in which the contextual elements is defined (or will be defined)
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Instructor Notes:
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2



Added fillets



Edit the part



Added a pad and limited it up-to-surface of the light blue component. This contextual element had to be defined in the “right insert” instance in order to reference the nearby blue component.
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Fully Constraining Contextual Parts It is important to fully constrain contextual parts to avoid unintentional distortion of geometry. In this example, Housing part is contextually designed and has external references to the geometrical elements of the Base.



Copyright DASSAULT SYSTEMES



The sketch of the pad is not fully constrainted.



The sketch of the pad is Fully constrainted.
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The housing part is rotated by a small amount.



The housing part is rotated by a small amount.



The geometry of pad is distorted.



The housing part is updated without any distortion.



On updating the Housing part, the contextual sketch is projected back onto the large green part. But the geometry of the housing part is distorted.



Fully constraining the housing part ensures that it maintains the expected location relative to the small brown pad.
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Fixing-in-Space Contextual Parts Moving a component can unintentionally cause geometry to move within a contextual part. Here the slot is fully constrained to the pad



Suppose a component is temporarily moved



Updating the small brown part projects the contextual sketch back onto the large green part. But the pad appears to be in the wrong location.
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To avoid unintentionally moving geometry in contextual parts, ensure that components are in their “assembled” position before updating contextual parts. To make this easy: • Fix-in-space components Unintentionally moving geometry in contextual parts may have adverse affects on scenes and drawings.



Instructor Notes:
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• Update the assembly to move components back in position before updating contextual parts
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Creating Assembly Features
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You will learn how to Create Assembly Features



Instructor Notes:
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What Are Assembly Features ? (1/3) Assembly features are features that are applied not only to a single part (in Part Design Workbench) but to a set of several parts of an assembly. Following are different assembly features: Split, Hole, Pocket, Add and Remove. Split



Splitting Surface



Disc 2



Disc 1 Split : This operation splits one or more parts with the splitting surface in a single instance.
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Hole



Instructor Notes:
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Hole: This operation creates hole passing through multiple parts in a single instance.
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What Are Assembly Features ? (2/3) Pocket : This operation creates pockets in multiple parts in a single instance.



Add : This operation adds a part to multiple parts in a single instance.
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Disc 1



Disc 2



Body being added



Instructor Notes:
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What Are Assembly Features ? (3/3) Remove : This operation removes material from all affected parts using the geometry of a part used in Remove operation in a single instance. Disc 1



Disc 2
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Body being removed



Instructor Notes:
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What Are Affected Parts ? Affected parts are parts of the assembly that will be involved in the assembly feature Affected parts become contextually linked
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Linked feature is created in affected part



Instructor Notes:
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Creation and edition at the level of the assembly You can see that split is refering to List of affected parts and linked features in them



Surface.1 which is a Split surface.
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Specifying Affected Parts Whatever assembly feature you want to create, you have to specify affected parts in the first appearing dialog box (Assembly Feature Definition dialog box).



Parts of the assembly that are not yet affected by the assembly feature. Select them by clicking them while using Ctrl and Shift keys
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Parts of the assembly that will be affected by the assembly feature. Select them by clicking them while using Ctrl and Shift keys



This option allows you to highlight in geometry the parts that will be affected



Instructor Notes:
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Affecting Tools: Move all parts of upper field into lower field Move all parts of lower field into upper field Move selected parts of upper field into lower field Move selected parts of lower field into upper field
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Assembly Split You need a surface or a plane to make a split, this surface can belong to one of the affected parts or not. 4 Select orientation of the split 1 Click on Split icon by clicking the arrow 2



Select the splitting surface



5 3



Validate the command



Specify affected Parts
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6
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Affected parts are splitted
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Assembly Hole When creating an assembly hole, you will create a sketch that will belong to the part containing the reference plane 1



Click on the Hole icon.



2



Select reference edges and surface for the Hole



4



In case of checked options about contextual design, “links” can be created between elements



5



Specify hole parameters values and types and validate



Reference face



The option “Add Series” allows you to define different hole’s specifications for each affected parts.



Reference edges



3a



Specify affected parts



See next page for more information.
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The hole goes through all affected parts
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Assembly Hole Using Series When creating an assembly hole, you can define different shapes of holes going thru parts of a product within the same assembly feature 1



It is intended that default specifications are well defined. Click on “Add Series”



A new tab named “Series 1” is created



2



Select in the list the parts to be affected by the new hole specification by double clicking on it (you can also multi select them and click on “Select”). You can highlight the part to verify the selection Define the new hole specification with “Hole definition” dialog box
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3



Instructor Notes:
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4



Return to step 1 to add other series. After validation specification tree contain the Assembly hole feature which can be modified in Assembly Design Workbench.
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Assembly Pocket Pocket is a Sketch based feature that requires an existing sketch. This sketch can belong to one of the affected parts or not. Specify pocket parameter values and types 4 1 Click on Pocket icon



Select the sketch which will be used to make a pocket



3



Specify affected parts
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2
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5



Validate the command



6



The created pocket goes through all affected parts
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Adding a Body to an Assembly The body you want to add to several parts can belong to one of these parts. It can even be its Partbody. 4 Validate 1 Click on Add icon



2



Select the body to add 5



Specify affected parts
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3



A linked copy of the body is added to each affected part
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Hiding all parts except one, you will see that there is an added body to it
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Removing a Body from an Assembly The body you want to remove from several parts can belong to one of these parts. It can even be its whole PartBody 1



Click on Remove icon



2



Select the body you want to remove



Validate the command



4



6



Specify affected parts
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A linked copy of the body has been removed from each affected part
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Isolating Contextual Parts
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You will learn how to severe the contextual relationships between driving and driven parts.



Instructor Notes:
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What Is Isolating Contextual Parts ? At times you may want to severe the contextual relationships between driving and driven parts.
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Here we are severing all contextual relations in the selected part.



Instructor Notes:
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Here we are severing an individual contextual relation while leaving other contextual relations intact
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Why Isolate Contextual Parts ? Contextual links may be severed because : The part is being released and you want to avoid inadvertent changes. The design is stable and you no longer have a need to drive changes from one part to other parts.
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You inadvertently deleted the assembly and/or components that define the context for contextual elements.



Instructor Notes:
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Isolating All Elements in Contextual Parts Isolating a part severs the contextual relationship with the driving components so that changes to driving parts no longer cause changes to the part that was formerly driven. Right-click the part to be isolated and select Isolate Part
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1



Instructor Notes:
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2



The node “External References” becomes “Isolated External References”
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Isolating Individual Elements in Contextual Parts You can isolate several individual contextual elements so that some elements remain driven. 1



Right-click the feature to be isolated in the contextual part and select Parent/Children…
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2



Right-click the node of interest and select Show All Parents to see External References



Right-click the External Reference of interest and select Isolate
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Analyzing Contextual Parts
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You will learn how to inquiry about the relationships between driving and driven parts.



Instructor Notes:
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What Is Analyzing Contextual Parts ? To help understand contextual parts, inquiries can be made about relationships between driving and driven components, elements, and documents. Here we are inquiring about the relationships between driving and driven components. In this case the “top block” component is a contextual part that is driven by the “bottom block” component. In turn, the “top block” drives the “round pad” component which is another contextual part.



Copyright DASSAULT SYSTEMES



Here we are inquiring about the relationships between driving and driven elements and documents. In this case sketch.1 has some External References to Pad.1 in the “bottom block” instance of another CATPart.



Instructor Notes:
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Inquiring About Parent and Child Components Analyze dependencies to understand the relationships between driving and driven components. 1



Select the component to be analyzed



2



Select Analyze > Dependencies



2 3



Activate the Associativity button and deactivate the Constraints button



4



Right-click and select Expand All to show the parents and children 3
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Parent



Child



Parents drive the part being analyzed Children are driven by the component being analyzed
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Inquiring About Parent and Child Elements & Documents View parent/children to understand the relationships to external elements and documents. 2 Right-click on the node of interest and select 1 Right-click the feature to be analyzed in the contextual part and select Parent/Children…
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To help you graphically see the relationship between driving and driven elements, temporarily show (un-hide) External Reference elements and then select elements to highlight them.



Instructor Notes:
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Show All Parents to see External Reference elements and documents
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Deleting Contextually-related Components
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You will learn how to delete components that are contextual or that drive contextual parts.



Instructor Notes:
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What is Deleting Contextually-related Components? (1/2) Additional options are available for managing data when deleting components that drive contextual parts or when deleting contextual components. Deleting a driven Part: Here we are deleting the “original” instance of a contextual part. We are warned to establish another component as the new “original” instance.



Left Insert (Original Instance)
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Right Insert (Copy of Original Instance)



Instructor Notes:
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You can change context by using “Define Contextual Links” from contextual menu and define contextual links for a part which is not in context. Housing
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What is Deleting Contextually-related Components? (2/2) Deleting a Driving Part
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Here we are deleting a component that drives a contextual part. We have the option to delete the contextual components that are driven by the component being deleted.



Instructor Notes:
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Deleting Driving Components When deleting a component you will be optionally able to delete any contextual components that it drives because contextual components are children of driving components. Select the component to be deleted and press 



1
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Note that “Delete all children” is not checked.



3



Specify whether or not to delete: • Assembly constraints if any • Contextual components that are driven by the component being deleted if any



Instructor Notes:
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2



Press More >>



Product Design



Deleting Contextual Components After deleting a contextual component you will have to isolate any remaining instances or establish one as the new “original” contextual component. 1



Select the component to be deleted and press 



3a
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3b



If “Isolate Part” is selected, there are no more links between this component and the other components in the product in which it is instantiated. If “Define Contextual Links” is selected, the part becomes as the first instance of a contextual part.
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Press OK



2



3



Isolate remaining instances of the contextual part or define them in context using ‘Define Contextual Links’



(a) (b)



Be careful: regarding on how the part is designed, the result will not be positive
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Saving Contextually-related Documents
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You will learn how to save documents that are explicitly or implicitly related to contextual CATParts.



Instructor Notes:
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What Is Saving Contextually-related Documents ? Special attention is required when saving documents that are explicitly or implicitly related to contextual parts.



Contextual parts reference: • Elements in driving CATParts
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• Specific instances of CATParts in specific CATProducts



Saving one document with a new file name may require that a related document also be saved



Instructor Notes:
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Here the Small Block part references elements in the “bottom block” instance of the Large Block part
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Saving Driving CATParts
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After saving a driving CATPart with a new file name, you will also need to save the driven CATParts and the parent CATProduct because they reference to the driving CATPart file name. 1



Open the assembly that references the CATPart to be Saved As



2



Click on the menu ”Save As…” to save the driving CATPart



3



Click OK to proceed with the save



4



Save contextual CATParts that are driven by the CATPart that was Saved As



5



Save the CATProduct that is the parent of the CATPart that was Saved As
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You might find it more convenient to use “Save Management…”
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Saving Contextual CATParts
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After saving a contextual CATPart with a new file name you will also need to save the parent CATProduct because it references the contextual CATPart file name. 1



Open the assembly that references the CATPart to be Saved As



2



Save As the contextual CATPart



3



Save the CATProduct that is the parent of the CATPart that was Saved As



4



Click OK to proceed with the save



Instructor Notes:
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You might find it more convenient to use “Save Management…”
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Saving Parent CATProducts After saving a CATProduct with a new file name you will also need to save contextual CATParts that were defined in-context of the CATProduct because these CATParts reference the CATProduct file name. Open the assembly that is to be Saved As



2



Save As the CATProduct



3



Save contextual CATParts that were defined in-context of the CATProduct that was Saved As



4



Click OK to proceed with the save
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You might find it more convenient to use Save Management
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Copying CATProducts Using Send to Directory You can save the CATProduct and related contextual parts using File > Send to > Directory, to create another copy of the CATProduct with all related files. 1



Click on File > Send to > Directory from File Menu.



2



Select the files to be copied and specify the destination folder where the files will be copied.



List of available files for copy



Click on these buttons to copy the selected file(s).
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Files selected for copy



You can copy all files in the source by clicking on “Copy all files” button.



Destination folder



Instructor Notes:



Make a demo using existing CATProduct and explain how this copy is different from Save As or Save Manageement.
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Design in Context Recap Exercise: Earphone 20 min



In this exercise, you will:
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Create and position a new part in a Product. Design this new part in context: Reusing external elements. Reusing sketches of another part to create sketch-based features. Creating new individual features.



Instructor Notes:
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To Sum Up In this lesson you have seen how to design contextual parts in an assembly. You have also seen how to: Create Contextual Parts : Contextual parts can be created by reusing external geometrical elements and / or published parameters of other parts. Edit Contextual Parts : Editing a driving part impacts the changes in the contextual parts whereas editing driven part impacts only the contextual part and its non contextual instances . Create Assembly Features: You have seen how to create Assembly Split, Hole, Add and Remove features.
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Manage Contextual Parts: You have seen how to isolate, save, delete and analyze contextual parts.



Instructor Notes:
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Creating and Using Published Geometry In this lesson you will learn what is published geometry and in which conditions it can be used
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Introduction to Publishing Geometry Creating Published Geometry Using Published Geometry Replacing Published Components Recap Exercise: Webcam To Sum Up



Instructor Notes:
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Introduction to Publishing Geometry Publishing geometrical elements is the process of making geometrical features available to different users. This operation is very useful when working in assembly design context. Publishing Geometry is also useful while constraining various components of an assembly. It is useful when we replace components especially when the component being replaced is involved in assembly constraint or drives other component.
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In this example, the pad of part 2ndCarter is limited by published elements Ref_Surf – a top surface and Low_Surf – bottom plane. Hence this pad is contextually linked to 2ndSurfaces.
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In this lesson, we will learn how to publish geometry, but you can publish parameters as well.
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Creating Published Geometry
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You will learn how to publish geometric elements of components



Instructor Notes:
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What is Publishing Geometry ? Publishing geometry of a component means associating a name to it so it will be recognized by other documents. For publishing geometry you have to edit the part and then select Publication from Tools Menu. You can also create publications at a product level.
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Sketch.6 is published as Sketch_Carter



The published elements are visible only in specification tree. You can select the pointed geometrical element by selecting the publication in the specification tree.



Instructor Notes:



To publish, selected geometry of a part body “Publish a face,edge, axis or vertex” option has to be activated.
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Why Publish Geometry ? Publishing geometry has many benefits: To label geometry and give it a name that can easily be recognizable (particularly in case of publishing edges, faces, etc.) To make some particular geometry easily accessible from one part of the tree. An option allows you to select as external reference only the published elements. In this case, Publication permits you to pre-select the elements that you allow to use as external references. To ease replacement of one component of the
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assembly by another. Published elements that have the same names are automatically reconnected, as you would have to reconnect them all one by one if they were not published.



Instructor Notes:



Highlight that the key benefit of publication is for replacement purpose.



Copyright DASSAULT SYSTEMES



Product Design



What Kind Of Geometry Can Be Published ? Many types of geometries can published : Wireframe features (Points, Lines, Curves, Planes) Whole sketches Bodies (Part Body, other body) Part Design features (pad, pocket, hole,etc.) Generative Shape Design Features (Extrudes Surfaces, Offsets, Joins etc.) Free Style Design features (Planar Patches, Curves etc.)
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Sub Elements of all Geometrical Elements (Faces, Edges, Vertices etc.)



Instructor Notes:
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Published Elements in the Tree The tree displays names of published elements of a component under its Publication node. When an external reference is connected to a published geometry, it is shown also.



Here are the published elements of the component “2ndSurfaces” The green gear signifies the “original” instance of a part that is contextual (driven by another part)
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Copies of external geometry that are synchronized with published geometry are signaled with the capital P



Capital P will be green when the link to external geometry is updated ( and be replaced by this symbol when not synchronized (
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)



)



Product Design



Publishing Geometry (1/3) Publication will concern the active component and is available both in Assembly Design Workbench and Part Design Workbench 1



Activate the component in which you want to publish geometry



2 3



Select “Publication…” in Tools Menu Select geometric element you want to publish
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4



Instructor Notes:
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As soon as selected, the element is added in the list of published geometry. To modify its published name, select its row then its name cell
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Publishing Geometry (2/3) You can publish as many elements as you want. 5



Key the name you want to associate to the selected element



6



Repeat step 3 to 5 to publish other elements
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7



It is not mandatory to publish all the geometry in one shot, you can come back later to the Publication of the component and add some other published geometry Published geometry is displayed under Publication node of the component



Instructor Notes:



Copyright DASSAULT SYSTEMES



Click on OK to validate
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Publishing Geometry (3/3) Concerning part components, you can as well publish their geometry from Part Design Workbench as from Assembly Design Workbench



Part Design Workbench Tools Menu
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Published Geometry in Part Specification tree



Instructor Notes:
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Changing a Published Element You can also replace the published element by another one Edit the Part or component on which you want to change the published geometry



1



3
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4



2



select the row



select the new element in geometry
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Click “Yes” to validate



Select “Publication” in Tools Menu
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Using Published Geometry
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You will learn in which cases you can use published geometry.



Instructor Notes:
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When Can You Use Published Geometry ?
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Published geometry can be used in any command that requires geometric elements. It means in assembly constraint edition and design in context. But publishing geometry is especially useful when you replace components which are used in assembly constraints or contextual design.



You can use published geometry to specify geometric elements involved in assembly constraints In this case, we had the setting “Use published geometry of any level” activated and could only select published geometry to define the coincidence constraint.



Instructor Notes:
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You can use published geometry as external reference for contextual design



In this case, to design MouseCarter Part , we used two published elements of PublishedReferences component : Sketch_Carter and Ref_Surf.
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User Setting : Use Published Geometry to Constrain (1/3) There is a setting that prevents from using other geometry than the published one when creating Assembly Constraints. Select Options... from the Tools menu



2
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1
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Select the “Assembly Design” branch under “Mechanical Design” node



3



Select Constraints tab



4



Activate one of the “Use published geometry” options



Product Design



User Setting : Use Published Geometry to Constrain (2/3) When imposing the use of published geometry, you can choose between two behaviors.



Only these two geometric elements are published at the level of the bolt assembly



This face is published at the level of the nut component and not at the level of the bolt assembly



We have inserted the bolt assembly in another assembly also containing two plates



The behavior of CATIA won’t be the same whether the active option is…
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…This one…
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…or This one.



We have selected these two faces in order to put a contact constraint between them
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User Setting : Use Published Geometry to Constrain (3/3) When imposing the use of published geometry, you can choose between two behaviors With this option…
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… It will not be possible to constrain because the face of the nut is not published at the required level



Instructor Notes:
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With this option…



… Contact constraint will be created because the face of the nut is published at least at a sub-level



Product Design



Using Published Geometry in Assembly Constraints (1/2) You can select published geometry to define assembly constraints between two components. There are two cases: A. All elements involved in the constraint are published. B.



At least one element involved in the constraint is not published.



Case A: All elements published 1



You can activate one of the “use Published geometry”options



2



Select your constraint
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3



Select Elements directly in geometry or from Publications in the specification tree.
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Using Published Geometry in Assembly Constraints (2/2) Case B: At least one of the elements is not published



1



Select your constraint



2



Select non published elements in geometry



3



Select published element under publication node in the tree or in the geometry



(2)
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(3)
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User Setting : Only Use Published Geometry for External References This setting prevent you from selecting other geometry than published one when creating external reference



1



Select Options... from the Tools menu



2 3



1



Select the “Part Infrastructure” branch under “Infrastructure” node Activate the “Restrict external selection with link to published elements”



2
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With this option activated, selection of external reference that is not published will not be possible, cursor will have this shape when moving around non published elements.
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Using Published Geometry in Contextual Design (1/2) You can select published geometry as external reference to design associative parts in context of the assembly.



1



Activate the Part that you want to design in context



2



Create a Pad



Select up to surface as type of first limit



Select as limit the Ref_surf publication of Published Reference component (you can either select it in the tree or in the geometry)
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Click on OK



Here is the result



Instructor Notes:
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Select as profile the Sketch_Carter publication of Published Reference
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Using Published Geometry in Contextual Design (2/2) Published geometry as any other geometry does appear under External Reference node when used to design another part in context of the assembly.



3a



If the option “keep link with selected object” was on while editing the part, then…



…the copies of published geometry are under External References node of the part and are associative
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Capital P indicates that the element is linked to an external reference that is published ( )



Instructor Notes:
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3b



If the option “keep link with selected object” was off while editing the part, then…



…the copies of published geometry are under an Geometrical Set of the part and are not associative



Red lightning indicates that the Wireframe & Surface element is a datum (non associative element that you can not modify) ( )



Product Design



Replacing Published Components
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You will see the importance of Publication while replacing components.



Instructor Notes:
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What is Replacing Published Component ? Published geometry becomes useful when you replace a component and when the replaced component is involved in a constraint or driving other contextual components. Concerning Design in Assembly context , the best way to replace a component driving geometry of other components is to use Published geometry.
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With published geometry, constraints Without published involving the replaced geometry, constraints component can be involving the replaced preserved component must be reconnected



In this case, the part containing all the driving geometry(Sketches and Surfaces) has been replaced.
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With publications, the assembly constraints involved with replaced component are restored.
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Reconnecting a Constraint (1/2) A constraint can become unresolved after a replacement of a component or connected to a wrong geometric element.You have the possibility to redefine geometric elements involved in it. 1



Edit the constraint you want to reconnect



2
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Instructor Notes:



Copyright DASSAULT SYSTEMES



Expand the dialog box



Select in dialog box the geometric element to reconnect and then click on Reconnect
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Reconnecting a Constraint (2/2) The Constraint dialog box let you have a look at geometric elements involved in it.



4



5



Select the new connected geometric element



Edited constraint is now connected to the just selected element.
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You can Click on OK and Update the constraint
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Replacement Of a Non Published Driving Component (1/3) When you replace a component which contains geometry leading other contextual components of the assembly, driven components will have to be re-designed to be reconnected to the new driving geometry. “MouseCarter” part is contextual to “FirstMouse” assembly and linked to “Unpublished References” part



Replace “Unpublished References” with another Part (“PublishedReferences.CATpart”)



1
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2



The two external references are synchronized (green light) with geometry of the driving component “Unpublished References”.
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An ‘Impact on Replace’ window appears. Select the choice to replace the current or all instances and Click OK.
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Replacement Of a Non Published Driving Component (2/3)



3



Contextual data are no more synchronized and you have to re-design the contextual part 6



“PublishedReferences” is not recognized by contextual geometry of “MouseCarter”



4



2x



5



Copyright DASSAULT SYSTEMES



2x



Select sketch of replacing component as Profile



Edit “MouseCarter” part Edit “Pad1” feature



7



Select surface of replacing component as Limit



References are no more synchronized because the component they are referencing is no more in the assembly
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8



Click on OK
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Replacement Of a Non Published Driving Component (3/3) Re-design parts in context creates other external references, you have to delete the old ones that have become useless. Delete useless External References
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9



10



[CTRL] + Left Mouse key pressed + [DEL]
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Contextual part references now only geometry of the replacing component
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Published Geometry and Assembly Constraints (1/4) When you replace a published component that is involved in assembly constraints, it is possible thanks to published geometry to have automatic reconnection of the constraints. 1



Select the component to be replaced and from contextual menu, select ‘Replace component’



There are two cases for Replacing component: Case (2a) and Case (2b): 2a



Select the component to be replaced as ‘CRIC_SCREW2.CATPart’. No Geometry is published in CRIC_SCREW2 component



2b



Select the component to be replaced as ‘CRIC_SCREW3.CATPart’. Geometry is published in CRIC_SCREW2 component



The “Impacts On Replace” dialog box is displayed. Validate by clicking on OK.
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3
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Result for Case 2a



Result for Case 2b
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Published Geometry and Assembly Constraints (2/3) Case 2a: Geometry involved in constraints not published



Cric-Screw



Cric-Screw-2 No Published Geometry in Cric_Screw_2
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Published Geometry



No re-connections of constraints Two constraints in the assembly are connected to published elements of “CRIC_SCREW” component.



Instructor Notes:
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Constraints have become unresolved after component replace. You have to manually reconnect the broken constraints.
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Published Geometry and Assembly Constraints (3/3) Case 2b: Geometry involved in constraints published



Cric-Screw Cric_Screw_3 Published Geometry



Published Geometry
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You have to ensure that published names are exactly matching for the component which is replacing the existing one.



Re-connections of constraints Constraints are connected to published elements of “Cric_Screw”
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Constraints are connected to published elements of “Cric_Screw_3”
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Published Geometry and Contextual Design (1/2) When you replace a published component which contains geometry leading other contextual components of the assembly, there can be automatic reconnection to the external references depending upon the presence of Published Geometrical elements in the part being replaced. Case 1a: Replaced part has no published geometry Use contextual design to design the Mouse carter
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Those two published geometric elements of “PublishedReferences” are used to design “MouseCarter”



External references are synchronized with published geometry of “Published Reference”
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Replace “PublishedReferences” with “UnPublishedReferences” part.



No published geometry in “Unpublished References”



External references are no more synchronized with any geometry You have warnings about non synchronized geometry
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Published Geometry and Contextual Design (2/2) Case 1b: Replaced part has published geometry
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“PublishedReferences” has been replaced with “PublishedReferences2” which has the same published geometry as the original PublishedReferences part.



External references are synchronized with published geometry of “Published References”
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Resynchronization



External references are synchronized with published geometry of “PublishedReferences2”
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Publication Recap Exercise: Webcam 25 min



In this exercise you will experiment the benefits of Publication while replacing a component. You will:
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Position components and notice that assembly constraints become unresolved after replacement of the reference component. Design a part in context and notice that its links are broken after replacement of the reference component. Publish reference elements and notice that contextual links and positioning links are reconnected automatically after replacement of the reference part.



Instructor Notes:
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To Sum Up In this lesson you have seen how to : Publish Geometry : Publishing geometry means associating a name to it so that it will be recognized by other documents. You can publish any geometry like wireframe features(points, lines, curves), part design features (pads, pockets,holes), sketches, Generative shape design features(extruded surfaces, offsets, joins), sub elements of all geometrical elements (faces, vertices). Use Published Geometry in Contextual Design: You can design contextual parts by using external published geometrical elements like sketches, planes, points. Use Published Geometry while creating Assembly Constraints : You can use published geometrical elements while creating assembly constraints between components.
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Replace parts with published Geometries : When you replace components with published geometry, you can have automatic reconnection of external references of a replaced contextual part and assembly constraints.
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Flexible Sub-Assembly You will learn how to reuse several times the same sub-assembly with its components in different relative positions.
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Introduction to the Flexible Sub-assemblies Flexible Sub-Assemblies Using Flexible Sub-Assemblies Managing Flexible Sub-Assemblies Propagating Position to Reference Recap Exercise: Engine Assembly To Sum Up



Instructor Notes:
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Introduction to the Flexible Sub-assemblies Products or assemblies contains components as part, and also assemblies named subassemblies which are able to be instantiate. These instantiation may not have the same configuration from one to the other in the root product.
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Defining a product as a flexible sub-assembly allow this one to have a different position without modifying the referenced product.
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Flexible Sub-Assemblies
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You will learn how to make an assembly “flexible” thus allowing you to change the position on the fly of its parts without changing the stored assembly



Instructor Notes:
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What Are Flexible Sub-Assemblies? A flexible Sub-Assembly is a Sub-assembly whose child components can be moved disregarding the fact it is not the active component. Relative positions of its child components can be different than those stored in the reference CATProduct File. There you can see 4 instances of the Leg sub-Assembly : notice that the components of leg are not positioned the same way in each instance ; this is possible because all instances of Leg Assembly are flexible Leg.1



The purple little wheel to the left corner of the CATProduct icon identify a flexible sub-assembly Leg.3
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Leg.4
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Leg Relative positions of components in the reference of the SubAssembly



Leg.2
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Making a Sub-Assembly Flexible Rigid/Flexible sub-Assembly tool is a switch : you click once to make an assembly flexible and you click on it again to make the assembly rigid 1



Select the Sub-Assembly



2



Flexible/Rigid Sub-Assembly



3



Selected Sub-Assembly is now Flexible
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Purple wheel means flexible instance
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Note that you can make the sub-Assembly rigid again with the same icon
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Positioning Components Of a Flexible Sub-Assembly(1/2) You can position components by freely moving them with the compass or by constraining them. In both cases the Rigid/Flexible state is important. Freely moving Components In this case the compass has been put on a component of a Flexible Sub-Assembly.
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In this case the compass has been put on a component of a Rigid Sub-Assembly.



Root assembly is active, so the compass will drag the whole Rigid Sub-Assembly
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Copyright DASSAULT SYSTEMES



Root assembly is active, but as the sub-Assembly is flexible, the compass will only move the selected component
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Positioning Components Of a Flexible Sub-Assembly(2/2) Relative Positions of components of a Flexible Sub-Assembly are stored with instance information in containing CATProduct. Constraining Components When you create a constraint between: a component of the active assembly …



When you create a constraint between: a component of the active assembly …



flexible instance And a component of a Flexible sub-assembly …
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… And a component of a rigid sub-assembly …



Constraint involves the component and the whole Rigid Sub-Assembly
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Constraint involves the component and the selected component of the Flexible sub-assembly
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What Is Mechanical Structure? There are two types of structure when you use flexible Sub-Assemblies Product Structure



Mechanical Structure



Flexible Sub-assembly does not exist anymore in Mechanical Structure tree
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Components and constraints of Flexible Sub-Assemblies are considered as direct children of the root assembly in mechanical Structure tree



Product Structure Tree shows which assemblies and sub-assemblies Parts and constraints belong to



Instructor Notes:



Copyright DASSAULT SYSTEMES



Mechanical Structure Tree shows what components you can constrain together (they are at the same level)



Product Design



Viewing Mechanical Structure Activate the Assembly or Sub-Assembly you want to analyze



Copyright DASSAULT SYSTEMES



1
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2



Select Mechanical Structure from Analyze menu
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Using Flexible Sub-Assemblies
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You will learn to manipulate Flexible Sub-Assemblies



Instructor Notes:
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What Can You Overload with Flexible Sub-Assemblies? Once the sub-assembly is flexible, Numerical Value, Activity status, Orientation (Same or Opposite), Driven/Driving property can be overload to modify locally its internal definition, or deal with under/over constrained situations
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Flexible Sub-Assembly
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Rigid Sub-Assembly
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Activate / Deactivate Status



Copyright DASSAULT SYSTEMES



Flexible Sub-Assembly



Concerning methodology using flexible sub-assemblies, you can change the Activity Status on a constraint
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Driven / Driving Property



Copyright DASSAULT SYSTEMES



flexible Sub-Assembly



Concerning methodology using flexible sub-assemblies, you can toggle the driven / driving status on a contraint.
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Numerical Value



Rigid Sub-Assembly
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Flexible Sub-Assembly



On a flexible sub-assembly, you can modify numerical values without impacting others instances



Instructor Notes:
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Managing Flexible Sub-Assemblies
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You will learn how to use and see impacts of flexible / rigid command on a large assembly which contains several levels of sub-assemblies



Instructor Notes:
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Description Of the Root Assembly (1/3) We start describing and explaining each level of the Root Assembly in order to see impacts of the Flexible/Rigid command :
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Components of the first level:
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Angular constraint



This assembly contains three parts. A driving angular constraint was created
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Description Of the Root Assembly (2/3) Components of the second Level: This assembly contains three instances of the last Product and one part. A specific angular constraint was created to position each sub-assembly to the part.
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x3
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Description Of the Root Assembly (3/3) Hierarchy structure of the Root Level:
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This assembly contains two instances of the level 2 .CATProduct and one part.
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Use Flexible/Rigid Command On the Ass_Level2 Assembly



Use the Flexible / Rigid Command to overload position of child components of one product instance (Ass_Level1). You can modify value of angular constraint and change the subassembly configuration. The other instances stay in the same relative position as in the reference CATProduct (Rigid Sub-Assembly)
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Rigid subassemblies



Rigid sub-assembly
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Flexible subassemblies



Flexible sub-assembly
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Use Flexible/Rigid Command On the Root Assembly Using the Flexible/Rigid Command to overload position of child components of one product instance ( Ass_Level2) does not impact mechanical structure of its child instances. All product instances of inferior levels stay rigid ( in the same relative position as in the respective reference CATProduct).



Flexible sub-assembly
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Rigid subassemblies



We can drive constraints of the ‘Ass_Level2 (1)’ instance without impacting mechanical structure of the ‘Ass_Level2 (2)’ instance. By default, all ‘Ass_Level1’ stay rigid.
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Propagating Position to Reference



Copyright DASSAULT SYSTEMES



You will see what is propagating position to reference.
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Propagating Position (1/2)



1



Modify position of the Flexible Base Instance. This Product contains 2 sub-assemblies : Base.CATProduct Base_unit.CATProduct
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Flexible sub-assembly
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: flexible instance : rigid instance
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Propagating Position (2/2) 2



Apply overloaded position to reference Select the flexible Base instance MB3+ ….object+Propagate position to reference



Result : all rigid instances should have the same position than the flexible one.
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Internal position of flexible instances are not impacted by the command.
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After an update if needed
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Engine Assembly Recap Exercise : Flexible Assemblies 45 min



In this recap exercise you will create a piston assembly by inserting various components and constraining them.
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You will then instantiate multiple instances of Piston assembly into Engine assembly, position them and make these sub assemblies flexible. You will demonstrate behavior of flexible subassemblies by rotating the crank to see pistons and connected parts occupy various positions. You will use following commands : Assembly Constraints Propagate position to reference Rigid/Flexible Assembly



Instructor Notes:
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To Sum Up … In this lesson you have seen what are flexible sub assemblies. You have also seen that : A flexible sub assembly is indicated by the purple colored wheel at the left corner of the icon. Rigid sub-assemblies are always synchronous with the original product, whatever mechanical modification you perform, but flexible sub-assemblies can be moved individually, without considering the position in the original product A flexible sub assembly of a product is never displayed in its mechanical structure
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You can edit the constraints defined for flexible sub-assemblies. The changes made to these constraints do not affect the constraints defined for the original product contained in the reference document.
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Working with Large Assemblies You will learn how to optimize the display performances of large assemblies.
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Introduction to Working with Large Assemblies Hiding Components Deactivating Representations Deactivating a Component Selective Load Using Visualization Mode Summary of Modes Recap Exercise : Washing Machine To Sum Up



Instructor Notes:



Copyright DASSAULT SYSTEMES



Product Design



Introduction to Working with Large Assemblies In case of complex industrial assemblies, the root assembly contains large number of components, with large number of instantiations of components, thus increasing the size of the final assembly. This decreases the performance of CATIA and it takes longer time open, zoom, pan, update and save large assemblies. It also takes more time to generate and update drafting views.



Copyright DASSAULT SYSTEMES



In this lesson you will see how improve visualization and CATIA performance while working with large assemblies by:
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Hiding components which are not being edited Deactivating Representations Deactivating components Selectively loading only necessary components Using Visualization Mode



Product Design



Hiding Components
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You will see how to hide components to improve performance and reduce clutter in “show space” and exclude components from drawing views.
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What Is Hiding Components ? Hiding components can improve performance and reduce clutter in “show space”. Hiding also excludes components from drawings views. Here one instance of the Connector Shell is hidden or no-shown.
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Hide/Show state is stored in CATProduct files so that the state is maintained when the assembly is opened. Hidden components are not visible in “show space” or in drawing views.
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The component’s icon is dimmed in the tree.



Here an assembly is hidden.



Hiding components is similar to deactivation of representations, but with the added advantages of : • excluding components from drawing views • part elements accessible to design parts and assemblies
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Differences Between Show and Hide This table compares the capabilities of Show and Hide while in Design Mode. Comparison of Show & Hide (in Design Mode) Behavior



Shown



Hidden



Fully Loaded



Fully Loaded



Memory and Performance Loaded in Memory Load and Update Performance



Normal



Normal



Display Performance



Normal



Faster, which is a benefit over being Shown



Visibility Visible in Show



Yes



No



Visible in No-show



Yes



Yes



Viewable in non-shaded mode



Yes



Yes



Viewable in DMU and sketcher sections



Yes



Yes



Visible in drafting



Yes



No, which is a benefit over being Deactivated



Accessible for adding Assembly constraints



Yes



Yes



Assembly Constraints re-generated/updated



Yes



Yes



Accessible to define translations & rotations



Yes



Yes



Assembly Constraints and Transformations
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Analysis Calculated in Clash, Clearance, Contact



Yes



No



Calculated in Mass Property analysis



Yes



Yes



Accessible for Measurements



Yes



Yes



Geometry features accessible in tree



Yes



Yes



Geometry may be edited



Yes



Yes



Geometry may be used to define sketches and features in other parts in the assembly (e.g. up-to-plane)



Yes



Yes



In-context features re-generated/updated (e.g. associativity)



Yes



Yes



Part Geometry
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Hiding Components Hiding can be performed on individual components, multi-selected components, or an entire assembly. 1



Select the component to be hidden



2
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3



You can hide more than one component at a time by selecting with the mouse while holding the [CTRL] key [CTRL] key
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Hide the component



The component is hidden
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Showing Components Showing a component makes it available for designing the assembly and inclusion in drawing views. 1



Select the component to be shown



2
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3



You can show more than one component at a time by selecting with the mouse while holding the [CTRL] key [CTRL] key
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Show the component



The component is shown
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Deactivating Representations
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You will see how to deactivate representations to improve performance, reduce clutter in “show space” and “no-show space”, and exclude representations from mass property analysis.



Instructor Notes:
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What Is Deactivating Representations ? Deactivating representations can improve performance and reduce clutter in no-show space. Deactivation can also be used to exclude representations from mass property analysis. Deactivated representations are excluded from mass property analysis. Deactivation state can be stored in CATProduct files. The default geometric representation is activated when opening an assembly. If there is only one representation, it is the default. Deactivated representations are not visible in “show space” or “no-show space”.
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The red axis symbol turn to gray. This symbol means the geometric representation is deactivated.



Deactivation of representations is similar to hiding components, but with the added advantages of : • improving performance when opening assemblies • excluding representations from mass property analysis
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Why Deactivate Representations ? (1/2) Deactivating representations provides following benefits : Mask Active representations in the specification tree and in the geometry : By this means, you choose to visualize the geometric representation of CATIA elements, belonging to a CATProduct. With the Deactivate Node functionality, only the selected element is hidden. Whereas with the Deactivate Terminal Node functionality, the last node' s elements of the selected node are masked.
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Improve Performance : Deactivating representations will not load these components in memory. This improves the performance of CATIA. CATIA takes less time to open, pan, zoom and save large assembly documents. Hide Representations from No Show Space : By deactivating representations, these components are not represented even in No Show space. Hiding representations will move the representations in No Show space, causing cluttering of No Show space. Hence deactivating representations is useful than hiding representations.
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Why Deactivate Representations ? (2/2) Deactivating representations provides following benefits : You can activate or deactivate Shape representation in Tools -> Options -> Infrastructure, select the Product Visualization tab and check the box entitled Do not activate default shapes on open. The entity representation disappears, it is a profit for memory space. You can work only on the tree.
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Analysis of Assemblies : Deactivated representations are excluded from mass property analysis. At times you are interested to evaluate mass property of partial assemblies. You can deactivate representations which should not be considered for mass property analysis.
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Differences Between Activation and Deactivation This table compares the capabilities of Activation and Deactivation while in Design Mode. Comparison of Activation & Deactivation Mode (in Design Mode) Behavior



Activated



Deactivated



Fully Loaded



Fully Loaded



Memory and Performance Loaded in Memory Load and Update Performance



Normal



Normal



Display Performance



Normal



Faster, which is a benefit over being Activated



Visibility Visible in Show



Yes



No



Visible in No-show



Yes



No, which is a benefit over being Hidden



Viewable in non-shaded mode



Yes



No



Viewable in DMU and sketcher sections



Yes



No



Visible in drafting



Yes



Yes, even though not visible in the assembly



Assembly Constraints and Transformations Accessible for adding Assembly constraints



Yes



No



Assembly Constraints re-generated/updated



Yes



Yes



Accessible to define translations & rotations



Yes



No
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Analysis Calculated in Clash, Clearance, Contact



Yes



No



Calculated in Mass Property analysis



Yes



No, which is a benefit over being Hidden



Accessible for Measurements



Yes



No



Part Geometry Geometry features accessible in tree



Yes



No



Geometry may be edited



Yes



No



Geometry may be used to define sketches and features in other parts in the assembly (e.g. up-to-plane)



Yes



No



In-context features re-generated/updated (e.g. associativity)



Yes



Yes, after activating and updating the associated part
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Deactivating Representations Deactivation can be performed on individual components, multi-selected components, or all components in an assembly. 1



Right-click the component to be deactivated



The geometric representation of the component is deactivated. Note that only the selected instance is deactivated.
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3
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2



With the contextual menu select “Deactivate Node”



Use Deactivate Terminal Node to deactivate all parts within a selected assembly.



Deactivated component is represented by this icon in the tree.



You can deactivate more than one component at a time by selecting with the mouse while holding the [CTRL] key.



[CTRL] key
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Activating Representations Activating a representation makes it available for designing the assembly. 1



Right-click the component to be activated



2



Select Representations + Activate Node
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You can activate more than one component at a time by selecting with the mouse while holding the [CTRL] key [CTRL] key
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3



The red axis symbol turn to red.



Use Activate Terminal Node to activate all parts within a selected assembly.



Product Design



Saving Activation State (1/2) If you want to save your assembly with representation of some components deactivated you have to store their status in the CATProduct file. A command allows you to store activation state but you need to create the access to this command. 1



Select “customize …” command from Tools menu



2



Select Commands tab



4
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3
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5



Select all commands



Close Customize Panel



Drag and drop “Save Activation State” command into a toolbar



Product Design



Saving Activation State (2/2) This command will allow to keep activation state of components into the CATProduct files.



This assembly has one component with deactivated shape



If you save it without having clicked on the icon …
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… you will obtain this next time you will open the CATProduct.



One click on the icon will make all save operations of CATProducts in the session, keep activation states of components.
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If you click this icon and save your CATProduct …



…you will obtain this next time you will open the CATProduct.
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Using Deactivation when Opening an Assembly You can improve performance by deactivating automatically representations when you open assemblies. 1



Turn ON the option Do not activate default shapes on open



2



3
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4
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Select in the contextual menu “Activate Node”



Open an assembly



Multi-select the components
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Deactivating a Component



Copyright DASSAULT SYSTEMES



You will see how to deactivate components to improve performance, reduce clutter in “show space” and “no-show space”, and exclude it from Bill Of Material.
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What Is Deactivating Components? Deactivating a Component is removing its representation and instance. The operation is simultaneous in all the CATIA documents containing this element . This operation is shared by all the instances of this part. You can apply this functionality on CATProducts, CATParts and models. In this example, component Connector Shell is shown in activated and deactivated state.



Connect Shell
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Connector Shell in Activated State Deactivation state of a component is represented in specification tree by the symbol shown below :



Instructor Notes:



Copyright DASSAULT SYSTEMES



Connector Shell in Deactivated State Deactivated rcomponents are not visible in “show space” or “no-show space”.
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Why Deactivate Components ? Deactivating components provides following benefits : Hide Components from No Show Space : By deactivating components, these components are not represented even in No Show space, hence,causing less cluttering of No Show space.



Screws are activated



Screws are deactivated
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Analyze Bill of Material : Deactivating a component will not list this component in Bill of Material. Hence, it is useful to generate Bill of Material for various configurations of Assembly.



Bill Of Material with Screw Component in Activated State
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Bill Of Material with Screw Component in Deactivated State
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Deactivating a Component (1/2) 1



Select the instance and activate its contextual menu



1



The symbol in the specification Tree shows you that it is still possible for you to reactivate it by the reverse operation
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2



2



Select the Activate/Deactivate Component Its shape is deactivated and there are no traces of its specifications in the Bill Of Material
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Deactivating a Component (2/2)
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As opposed to deactivate a node, deactivating a component inside a assembly means deleting its representation in all the CATIA documents in which it is being referred.
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Effect of Deactivation on Bill Of Material (1/2) The deactivated and unloaded component is not displayed in Bill of Material 1



Access the Bill of Material of the entire assembly, when all its components are loaded and activated.
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Bill Of Material of the ‘Sub-clamp’ assembly



2



Unload ‘clamp4.1’



3



Deactivate ‘clamp2.1’



4



Hide ‘clamp1.1’
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Effect of Deactivation on Bill Of Material (2/2) Access the Bill of Material of the entire assembly.
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5
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Bill Of Material of the ‘Sub-clamp’ assembly
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Selective Load
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You will see how to specify the depth of an opened Product Structure
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What does this tool do? In the case of large assemblies, you may not have to load all the documents in CATIA. You need to load only those sub-assemblies and/or components which you wish to visualize and edit. ‘Selective Load’ tool allows you to manage progressive loading of a product by specifying the level of depth. This tool is functional if the options: “Load Referenced documents” is not checked (in Tools/Options/General) “Work with the cache” is checked (in Tools/Options/Infrastructure/Product Structure/Cache Management)
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And optionally “Do not activate default shapes on open” is checked (in Tools/Options/Infrastructure/Product Structure/Product Visualization)
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You specify the level of depth of the product structure: only one, two or all level Multi selection of components is available
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Selective Load (1/2) You will learn how to selectively load various components of an assembly using the ‘Selective Load’ tool. 1



Ensure the following CATIA Options are set. ‘Work with the cache system’ option is activated
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‘Load referenced documents’ option is deactivated



‘Do not activate default shapes on open’ option is deactivated. (This is an optional setting).
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Selective Load (2/2) 2



Click on the “Selective load” tool



3



Multi select the components to load



4



Click on the button to add items to the list



5



Specify the level of depth



6



Click OK to load the selected components.



Instructor Notes:



Copyright DASSAULT SYSTEMES



Product Design



Using Visualization Mode
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You will see how to use Visualization Mode to improve performance.
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What Is Called "Visualization Mode"? By default an assembly is loaded in design mode. Thus part’s definition of all components are loaded in memory (this involve exact geometry and parameters). This step can involve more or less time according to the assembly to load. Then to improve performance you can set CATIA’s option to load an assembly in visualization mode. In this mode, a representation of the geometry only is available. In visualization mode the representation of the geometry is loaded and the corresponding file is a cgr file.



Notice that the screw branch is expandable and therefore the PartBody is accessible.
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Notice that the screw branch is not expandable and therefore the PartBody is not accessible.



In design mode the exact geometry is available.
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Explain that key benefit of Visualisation mode is to improve the performance in case of large assemblies.
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Visualization Mode vs. Design Mode (1/2) You will see the differences between the Design mode and Visualization mode:



Behavior



Design Mode



Visualization Mode



Memory and Performance Loaded in Memory



Fully Loaded



Partially Loaded



Update Performance



Slow



Fast as entire geometry is not loaded



Display Performance



Normal



Tessellated geometry is loaded



Manipulation Performance (Zoom, Pan, Rotate)



Slow



Fast



Visible in Show



Yes



Yes



Visible in No Show



Yes



Yes



Viewable in DMU and sketcher sections



Yes



Yes



Visible in drafting



Yes



Yes, partially or fully loaded
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Visibility
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Visualization Mode vs. Design Mode (2/2) Behavior



Design Mode



Visualization Mode



Assembly Constraints and Transformations Unpublished Geometry accessible for adding / updating Assembly constraints



Yes



Yes, automatically switches to Design Mode



Published Geometry accessible for adding / updating Assembly constraints



Yes



Yes, partially switches to Design mode



Compute Clash, Clearance, Contact



Yes



Yes



Compute Mass Property



Yes



No



Compute distances



Yes



Yes, only approximate minimum distance



Geometry features accessible in tree



Yes



No



Geometry may be used to define sketches and features in other parts in the assembly (e.g. up-to-plane)



Yes



Yes, automatically switches to Design Mode



In-context features regenerated/updated (e.g. associativity)



Yes



Yes, automatically switches to Design Mode



Assembly Analysis
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Part Geometry
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User Setting : Turning On the Cache (1/2) Turning ON the cache system will cause CATIA to load automatically parts and models in Visualization Mode. The cache is a read/write path located locally on your machine or anywhere on your network and is used to store cgr files. The first time a component is inserted, it is tessellated. This means that the corresponding cgr file is computed and saved in the local cache as well as displayed in the document window. The next time this component is required, the cgr file which already exists (and not the original document) is automatically loaded from the local cache. 1



Select Options... from the Tools menu



2 Select “Product Structure” branch under “Infrastructure” node



3
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4
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5



Select “Cache Management” tab



Activate Work with the cache system



The cache system is not activated until CATIA is restarted



Product Design



User Setting : Turning On the Cache (2/2) without Cache System



with Cache System



Notice that the branch is not expandable and therefore the PartBody is not accessible.
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You can edit items



You work with the cgr files:



Right-clicking on a component and selecting Design Mode in the contextual menu also switches the part or model to Design Mode:
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Manually Switching to Design Mode Parts and models can be switched manually to Design Mode on the fly. 1



When opening an assembly with the cache activated, parts are loaded in Visualization Mode



Double-clicking a part in an assembly



2a switches it to Design Mode.



Note that all instances of the part switch to Design Mode.
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2b



Right-clicking selecting Design Mode also switches the part to Design Mode



Right-clicking an assembly and selecting Design Mode switches all parts in the assembly to Design Mode.
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Automatic Switch to Design Mode This setting allows you to put constraints between components on a product loaded in visualization mode.



1



Check that the “Automatic switch to Design Mode” option is activated



Select a constraint tool. Around a



2 geometry , the cursor will have this . Click the geometry
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shape
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The two constrained components switch to a



3 Mode (Exact) which enables to select elements.
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Assembly Constraints and Visualization Mode The existing Assembly Constraints are not resolved fully in visualization mode, we need to switch to design mode to resolve these assembly constraints. 1



Activate the product you want analyze



2



Select “Dependencies…” in the Analyze menu



3



Right-click the component and select Expand All to see the components in the network of constraints
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3



4



Switch to Design mode and again repeat Steps 2 and 3. You will find that these constraints are updated.
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1



2
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Summary Of Modes You will see a summary of the capabilities of Visualization Mode, Hide and Deactivate.



Visualization Mode



Deactivation



Copyright DASSAULT SYSTEMES



Hide
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Differences Between Modes This table highlights some key reasons for using Visualization Mode, Deactivation, and Hide. Comparison of Modes



Behavior



Design Mode



Visualization Mode



Deactivated Node



(Design Mode)



(Design Mode)



Hidden



Memory and Performance Loaded in Memory



Fully Loaded



Partially Loaded



Fully Loaded



Fully Loaded



Load and Update Performance



Normal



Faster



Normal



Normal



Display Performance



Normal



Normal



Faster



Faster



Visible in Show



Yes



Yes



No



No



Visible in No-show



Yes



Yes



No



Yes



Viewable in non-shaded mode



Yes



Yes



No



Yes



Viewable in DMU and sketcher sections



Yes



Yes



No



Yes



Visible in drafting



Yes



Yes



No



No



Accessible for adding Assembly constraints



Yes



Yes



No



Yes



Assembly Constraints re-generated/updated



Yes



Yes



Yes



Yes



Accessible to define translations & rotations



Yes



Yes



No



Yes



Calculated in Clash, Clearance, Contact



Yes



Yes



No



No



Calculated in Mass Property analysis



Yes



No



No



Yes



Accessible for Measurements



Yes



No



No



Yes



Geometry features accessible in tree



Yes



No



No



Yes



Geometry may be edited



Yes



No



No



Yes



Geometry may be used to define sketches and features in other parts in the assembly (e.g. up-to-plane)



Yes



Yes



No



Yes



In-context features re-generated/updated (e.g. associativity)



Yes



Yes



Yes



Yes



Visibility



Assembly Constraints and Transformations
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Analysis



Part Geometry
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Washing Machine Recap Exercise : Large Assemblies 20 min



In this exercise, you will practice working on large assemblies while optimizing CATIA performance. You will practice:
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Loading only the necessary components of an assembly Switching components from visualization to design mode in order to edit them Deactivating the representation of the parts not needed for the study
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To Sum Up (1/2) In this lesson, you have seen is how to improve performance of CATIA while working with large assemblies by : Hiding components : Display performance can be improved by hiding components which are not being edited. Deactivate Representations : Deactivated representations are not loaded in the memory and this improves performance of CATIA. CATIA takes less time to open, zoom, pan, save large assemblies. Deactivate Components : Deactivated components are not represented in Bill of Material of an assembly. Hence it is possible to generate several configurations of Bill of Material of an assembly.
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Selective Load: This command allows you to manage progressive load of a product, you can also specify the level of depth of loaded components. Using Visualization mode : With this mode, components are partially loaded (only cgr is loaded),which improves the peformance of CATIA. To edit the component, you need to switch to design mode.
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To Sum Up (2/2) Here is a summary of viewing an assembly document in various modes.



Component Status



NO SHOW (Hiding Components)
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UNLOAD (Unloading Components)



Visualization (Shape Representation)



Bill of Material (BOM)



NO



YES



NO



NO



Accessibility (possibility of applying constraints) YES (you can apply constraints between the hidden object and the other components in the Show space)



YES



YES (you can apply a constraint even if the shape is deactivated)



YES



NO



Deactivating a Terminal Node



NO



YES



YES



Deactivating a Component



NO



NO



NO
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NO



NO



Deactivating a Node



YES



Improvement in Performance



YES



NO
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Analyzing Assemblies to Prepare drawing In this lesson, you will learn how to analyze assemblies and prepare assembly drawings
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Introduction to Analyzing Assemblies Measuring, Sectioning, Clash Managing Scenes Product Structure Numbering Generating Annotations Generating Reports To Sum Up
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Introduction to Analyzing Assemblies (1/2) In this lesson, you will learn how to analyze assemblies. You will see how to measure distance between components, create sections, compute clash and analyze clash.



You can create scenes to represent various state, color and position of components in an assembly. Scenes are stored in the root product file.
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You can measure minimum distance between components.
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Introduction to Analyzing Assemblies (2/2) You can create exploded views in scene window.



In Product Design Workbench, you can three types of annotations : Weld Annotations, Flag with Leader and Text with Leader.
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You can generate Bill of Material and Listing reports using Analyze > Bill of Material menu. Using Generate Numbering command,you can associate numbers or letters to various components, which appear in the balloons in drawing generated from the CATProduct.
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Measuring , Sectioning , Clash In this lesson,you will learn how to make a space analysis of your assembly using CATIA V5 Space Analysis common tools:
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Introduction to Measuring, Sectioning and Clash Measuring Minimum Distance Sectioning Computing Clash To Sum Up
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Introduction to Measuring , Sectioning and Clash To make previsions for possible errors or to define box bounding for new part, tools in CATIA V5 are available to analyze assemblies: Analyzing Clearance Analyzing Clash Sectioning tool
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Measuring in the 3D view and in the section view to reuse parameter that drives a part in another part, in order to link their geometry
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Measuring Minimum Distance
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You will learn how to measure minimum distances and update them.
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About Measuring Minimum Distances Measuring Minimum Distance This tool will help you to measure minimum distance, at product level, in a group or between two groups, two components… Its main characteristic is its ability to be updated. If elements have moved you can update the measure.
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We will be able to make dynamic measures in Fitting or Kinematics Simulations using this function



Instructor Notes:



Copyright DASSAULT SYSTEMES



Product Design



How to Fill Edit Distance Window You will see how to give inputs to the Edit Distance and Band Analysis window. 1



Name your measure



2



Select the type of measure text field



Measure minimum



There are 5 possibilities: Minimum : measure minimum distance Along X: measure minimum distance along X Along Y: measure minimum distance along Y Along Z: measure minimum distance along Z Band Analysis : compute the areas on products corresponding to a minimum distance within a user-defined range
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3



Select the computation type Inside one selection :Each selected components are tested against all others in the same selection Between two selections :Each component in the first selection are tested against all components in the second selection Selection against all : Each component in the defined selection against all others in the document.



4



Select the products according to computation type
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1 2 3



4
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Measuring Minimum Distance (1/2) You will find out minimum distance between two components. 1



Click on Distance icon The Edit Distance Window appears



2



Fill the Edit Distance and Band Analysis window, then select the highlighted components as ' Selection 1'
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Select highlighted components
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Measuring Minimum Distance (2/2) Click apply to compute the distance The Preview window displays selected products and the minimum distance



4



Click OK to confirm
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3



If you do not check the automatic option click on to view the results in a separate viewer.
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Reading Minimum Distance Results You will read minimum distance results created. 1 Click on the 'Distance and Band analysis'icon then select the seat and the gas cylinder and apply. After this Computation, you get:



Minimum distance value Vector values from point 1 to 2 Point 1 coordinates Point 2 coordinates Element on which is placed Point 1
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Element on which is placed Point 2
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Updating Measure
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You will update measure by changing selection 1



In the tree, Double Click the measure to update The preview window and the Edit Distance window appear



2



Optional: Modify values or selection



3



Click on Apply to re-compute



4



Click OK to confirm



Measure before update



Click on to view the results in a separate viewer Object if it’s not automatic
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Measure after update
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Sectioning
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You will become familiar with Sectioning tools in Assembly Design
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Sectioning You will see how to create sections, position section plane and use section viewer to see assembly sections
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Introduction to Sectioning Creating Sections Positioning Main Section Plane Using the Section Viewer
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Introduction to Sectioning
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You will learn how to create sections and observe internal details of components and assemblies.
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About Sections Identify conflicts You can create Sections in the Clash Window Line segments represent the intersection of the plane with all surfaces and volumes in the selection. By default, line segments are the same color as the products sectioned.
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Check Distances
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Points represent the intersection of the plane with any wire frame elements in the selection.



See what is inside Components using 3D Cuts Check if your components are empty or not.
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General Process: Sectioning 1 From product



2



3 Position and resize the Section on the component to section



4



Select the Section command



Open and Manipulate the Section result
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5
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Save result in the tree (and in a file)



Select the components to section, else all are selected by default.
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How to Use Section Tools? (1/4) You will see how to define a section view using various section tools. 1



Click on Sectioning Icon



2



By default Definition tab is activated



3



Select Section mode



Section Mode: section plane section slice section box
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4



Select Volume Cut



Before applying Volume Cut
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After applying Volume Cut
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How to Use Section Tools? (2/4) 5 Click on Positioning Tab and position the



section plane using various positioning tools



Edit Plane Window is used for Precise positioning of section plane Place your Section plane on a Geometric Target
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Allows you to position the section plane according to 2 or 3 selections



Before



After Invert Normal direction
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Before



After Cancel Move
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How to Use Section Tools? (3/4) 6



Click on Result Tab and export the result with various options using the tools in the Result tab Export Section View Result window Clash detection in the Section Viewer
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Grid Switch



Before Edit Grid
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After Section fill Switch
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How to Use Section Tools? (4/4) 7



Click OK to validate
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8



Click on Behavior Tab and set the behavior of update
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Before Contextual Menu available in the Section Results Window



After
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Creating Sections
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You will learn the different ways to Section, and how to activate six cutting planes simultaneously
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About Section Creation



There are various kind of sections from which you can get section cuts. Section Plane Section Slice



Section Plane



Section Box
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Section Slice
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Section Box
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How to Create a Section You will learn how to create a section Click on the Sectioning icon.



2



Select the kind of Section you want to perform



3



Position the section plane
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1
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Creating a Section Plane



Copyright DASSAULT SYSTEMES



Create dynamically a section using a cutting plane 1



Choose the Products to section If no selection made, all components will be sectioned You can select or de-select products dynamically, during the section action, to take them into account or not. The plane created will cut only selected products



2



Click on



3



Select the “Positioning” tab and manipulate your section plane.



4



Select Geometrical Target



Initial Plane
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3



4



Changing Plane



Different location and orientation
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Positioning Main Section Plane
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You will learn how to position plane using edge as support and how to dimension main section plane
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About Section Manipulation By default, the section plane is : centered on the surrounding box center of the pre selected elements, oriented by the XY plane square shaped dimensioned according to the longest dimension between center of inertia and the furthest element Most of the time the section plane is not at the right position or size. You will have to:
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re – center it translate and rotate it re dimension it
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How to Manipulate a Section You can manipulate the section plane using the following options Re dimension the plane using Direct Manipulation Edit Position and Dimension command



Move the plane using
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Direct Manipulation Geometric Target Edit Position and Dimension command



Re-dimensioning Direct Manipulation



Rotating
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Edit Position and Dimension



Using Geometric Target
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Manipulating a Section Plane Re-dimension, move and rotate section planes 1 Edit the desired section plane by double clicking it



The appearance will change and arrows appear to help you moving your section plane



2 Move the cursor over the section plane, section plane edge or local axis system



3a 3a Re-dimension the section plane clicking and dragging plane edges



3b Move the section plane along its normal vector clicking over the plane and drag



3b



3c Translate the plane by pressing MB1 , then MB2 and dragging



3c Copyright DASSAULT SYSTEMES



3d Rotate the section plane clicking over the desired plane axis system and dragging



Use the Reset Position icon
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to restore the plane to its original position



3d
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Positioning Plane with respect to a Geometrical Target



1 Edit the desired section plane by double clicking on it



2 Select the “Positioning” tab and click on Geometrical Target icon 3



Point to the target of interest : Simply Click an Edge or an Axis to position the section plane normal to the desired edge Simply Click a Surface to position the section plane on the tangent to a surface
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Simply Click a Plane to position the section plane coplanar to this plane Simply Click on a Cylindrical Surface to position the Section Plane normal to the Axis Reset Position icon : Restore the plane to its original position
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The Plane is a representation of the section plane, to assist you in positioning it



Product Design



Positioning a Section Plane by Points and/or Lines Thanks to this tool, you can quickly position a section plane through specific entities. You just need to select some lines or points and the section plane will automatically cross the selected entities



1



Make your selection of points and/or lines in the geometry. To define a plane you have to select either 1 line and 1 point or 2 lines or 3 points
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2



The cursor changes to assist you make your selection. It identifies the type of item (point, line, cylinder, cone, etc.) beneath it.
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Positioning Plane Using the Edit Position Command (1/2) You will learn how to position the section plane more precisely. Edit the desired section plane by double clicking it



2



Select the “Positioning” tab and



3



Click on “Edit Position”
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1
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Positioning Plane Using the Edit Position Command (2/2) 4



Fill “Edit Position” Dialog Box Change the current position : Click X, Y or Z to position the normal vector (z-axis) of the plane perpendicular to the selected absolute axis system



Change the center of the plane coordinates : Values in Origin X, Y and Z boxes (absolute system coordinates)
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Move the section plane : Enter translation step, then click +Tx, -Ty, +Tz … to move the plane along the selected axis by the defined step (local plane axis system)



Rotate the section plane : Same as for the translation use, to rotate the plane around the selected axis by the defined step



Undo / Redo section plane move



5



Click close to exit and save last plane position



Instructor Notes:



Copyright DASSAULT SYSTEMES



Change the plane / slice / box dimensions Enter the width of the main section plane Enter the height of the main section plane Enter thickness of the box or the slice (distance between parallel cutting planes)
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Using Smart Target to Snap Section Box You will use Smart Target for Snapping section box 1



Click on Sectioning icon



2



Select “Section box”



2 3



Select the “Positioning” tab and click on “Geometrical target” icon



3 4



To snap the first side of the section box click on the plane desired of the geometry: this symbol appears



5
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5



Do the same thing to snap the second side Selected planes can be parallel or perpendicular



6



Click OK in the Sectioning Definition dialog box when done
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Using the Section Viewer
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You will study the section viewer and various tools to customize the section viewer.
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About Section Viewer To display the result of the section, in a particular interface special tools are available to: Fill Section Display Grid Modify Grid options Rotate section Lock 2D



grid Viewer contextual menu
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You can also add measures and annotations in the section view by enabling this option.



The grid can be automatically re-sized to section results when moving the section plane. De-activating this option means that the grid has the same dimensions as the section plane.



Instructor Notes:



Copyright DASSAULT SYSTEMES



Product Design



How to use Viewer Tools? Contextual Menu in the Viewer Apply the main window view point to the Viewer



Use Absolute Axis or section plane center as origin



Lock 2D Visualization



Choose style of Grid



Swap to symmetrical position
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Rotate 90°
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Edit Grid Properties Horizontal and Vertical Grid step Reset Grid steps to defaults
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Viewing Section View the generated section in a separate 3D viewer 1



Click on Fit All In icon to reframe the results window
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3



Edit the desired section plane
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2



Click on Results Window icon



4



Manipulate the Section
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Checking Clash in Result Window Detect collisions between 2D sections 1 Create a Section 2 Open the Section Result window



3 2



3 Click on the Clash Detection icon
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The section result must be filled to detect clash.
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Clashes detected are highlighted
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Computing Clash
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You will learn various ways to compute clashes in a digital mock-up.



Instructor Notes:



Copyright DASSAULT SYSTEMES



Product Design



What is Computing Clash (1/2) The various ways to compute clash are shown below: Part to Part Clash : It is the simplest tool to quickly detect clash between two components.
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This command can be accessed from Analyze Menu. This command identifies the clash / clearance / contact between two selected parts. The result is given by the traffic lights: Red : Clash is detected between selected components. Yellow: Contact is detected between selected components Green: No interference between selected components
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Clash computation using ‘Part to Part Clash’
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What is Computing Clash (2/2) Check Clash: It is powerful tool for clash detection and analysis. This command can invoked by clicking on ‘Clash’ icon. Check Clash window displays clash results for selected component(s).
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Preview Window
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How to Compute Clash?
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Compute Clash : This is the powerful tool for Clash Detection in Assembly Design workbench.
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Analyze Part to Part Clashes You can check for clashes and clearances between two parts in an assembly. 1



3



Select the two parts using key.



Choose the kind of Analyze to perform:
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Clash (Parts occupying same space or in contact) Clearance (Parts occupying same space zone, in contact, or separated by less than the defined clearance distance enter the value of the clearance)



2



Activate ‘Part to Part Clash’.



4



Click on ‘Apply’.



3



4 5



Check results



Check light : Red for Clash Yellow for Contact Green for Clearance
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Clash detected between selected parts is highlighted in the mock up
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How to Fill ‘Check Clash’ Window? Before Computing the Clash, you will have to fill the ‘Check Clash’ window. 1



Give a name to your measure



2 Choose Computation type



1



4



2 3



Clash: components occupy same space zone Contact: components in contact Clearance: components separated by less than the defined clearance distance Authorized penetration: components in intersection by more than the defined value
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3 Choose Selection type. Between all components : each component against all other products Inside one selection : within any one selection, tests each component of the selection against all other components in the same selection Between two selections : each component in the first selection against all components in the second selection Selection against all : each component in the defined selection against all other components in the document 4 Select the components (parts, products, groups,etc.) according to computation type
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Computing Interferences You will compute clash for an assembly 1 2



Click on Clash icon Fill the Check Clash Window



Copyright DASSAULT SYSTEMES



Name of the computation Type of computation : Contact/ Clash/ Clearance/ Penetration Computation Type: Between all Components / Selection against all / Inside one Selection /Between two selections



3



Select the components from the tree or 3D, according to options chosen in ‘Step 2’.



4



Click apply to calculate the Clash The Results are displayed in the ‘Check Clash’ window.



A Preview window displays the selected Clash
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2 3



4
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Analyzing Interferences Basic List By Conflict 1 Compute Clash Then Click on the results to be checked



• The Clearance/ Clash value is displayed • The Status changed from ‘not inspected’ to ‘Relevant’
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2



Click on the Status value to change it into Relevant or Irrelevant, If necessary



3



Click on the Comment of the selected result to add/modify the Comment



4



Filter Interferences to simplify result display, eventually Type: Clash/Contact/Clearance Value: Increasing/Decreasing Status: Irrelevant/Relevant/Not Inspected Compute status : New / Old / Modified



5



Then Click Apply Filters



6



Click OK to Exit
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Analyzing Interferences Basic List By Product 1 Compute Clash Then Click on the results to be checked



• The Clearance/ Clash value is displayed • The Status changed from ‘not inspected’ to ‘Relevant’



2



Click on « List by product » Tab to Display Clashes Product by Product



3 Click on the Status value to change it into Relevant or Irrelevant, If necessary 4 Click on the Comment of the selected result to add/modify the Comment
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5 Filter Interferences to simplify result display, eventually Type: Clash/Contact/Clearance Value: Increasing/Decreasing Status: Irrelevant/Relevant/Not Inspected Compute status : New / Old / Modified



6 Then Click Apply Filters 7 Click on OK to Exit



Instructor Notes:
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To Sum Up ... This concludes the sub lesson “Measuring , Sectioning and Clash”. You should be able to demonstrate:
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Measuring a minimum distance Creating sections Simple section Multiple sections Positioning section planes Computing clashes In the assembly Between parts



Instructor Notes:
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Managing Scenes In this lesson you will learn how to create, edit and manage Enhanced Scenes in Assembly document.
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Introduction to Lesson Introduction to Enhanced Scenes Creating Enhanced Scenes Editing Enhanced Scenes Managing Components in Enhanced Scenes Creating Explode in Enhanced Scenes Creating Drafting Views based on Scenes Creating and Using Scenes: Recap Exercise To Sum Up



Instructor Notes:
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Introduction to Lesson
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A way to different point of view of a CATProduct is the use of “Scenes”. This tool permit to have multiple “screenshot” of an assembly without modifying the root product itself.



Instructor Notes:
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Introduction to Enhanced Scenes
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You will be introduced to ‘Enhanced Scenes’ and the ‘Enhanced Scenes Workbench’



Instructor Notes:
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What are Enhanced Scenes Scenes enable capturing and restoring the state of components in an assembly in a saved viewpoint Scenes can be used to create assembly drawings.



Scenes can control: • Hidden state of components • Color of components • Position of components • Deactivation of representations



Scenes are stored in an assembly’s CATProduct file



Use Scenes to try new positions and then apply positions to the main DMU window product In Scenes, you can create reports. Check the DMU Basic course
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Scenes can be used to set the working state by hiding, coloring, and positioning components.



Instructor Notes:
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Scenes can be used to see the evolution of an assembly
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Enhanced Scenes Workbench Presentation Once you have enter the scene workbench, specific tools are available Scene browser is available in DMU/scene workbench. The List Mode can display more number of ‘Scenes’ at a time in the ‘Scenes Browser’



List Mode



Scenes tools:



Explode Product Save current viewpoint Copyright DASSAULT SYSTEMES



Over Load position Apply scène on the assembly Apply assembly on scene



Exit the workbench



Instructor Notes:
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Creating Enhanced Scenes
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You will learn how to create Enhanced scenes



Instructor Notes:
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What kind of Scene? When you define a scene, you have to choose between 2 kinds of overload mode “Overload” is the capability to “spatially restrain” a part in a scene. Overload Mode FULL: If the scene is “ fully Overloaded” it means all the parts will keep their positions whatever the modifications made in the assembly. In other words, The scene will not be updated.



Overload Mode PARTIAL: -By default none of attributes are overloaded (it means the scene will be updated if some parts are moved in the assembly).
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Why Partial? Because it is possible to overload a part in a “partial” scene. If you move a part in a scene context, Catia will consider that you have overloaded the part. Then, if you move this same part in the assembly context, it will not be updated in the scene



Instructor Notes:
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About Enhanced Scene Creation You have only one way to create a first Scene - using the Enhanced Scene icon You can create an Enhanced Scene with all components You can create an Enhanced Scene with selected components only



You can create the second scene
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Using the Enhanced Scene icon OR Using the previous Scene as a reference



Instructor Notes:
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Creating an Enhanced Scene 1



Find the perfect viewpoint for your Scenes



2



Click on the Enhanced Scene icon



3



Specify a Scene name



4



Choose between partial/Full overload mode



5



Manage your components



6



Exit the Enhanced Scene



3



The Main Assembly drives those states unless you modified it in the scene.
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5



4



On creation, all the Components are copying the state (Color, Position, Activation…) of the Main Assembly.



Instructor Notes:



Scenes capture the orientation of the session so be sure the orientation is correct before pressing the Enhanced Scene icon.



6



Move Components thanks to the compass, hide some or change color



5



Product Design Creating an Enhanced Scene with a Subset of the Assembly
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The components in a Scene can be limited to a component (and its children if the component is a sub-assembly). 1



Select a component



4



Scene includes only the selected component



2



5



Select Enhanced Scene



3



Specify a Scene name/overload mode



Exit the Enhanced Scene



Scene captures the current color, position, and hide state of components in the assembly at the time of creating Scene. When you enter into scene CATIA background turns Green



Instructor Notes:
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Creating a New Scene from an Existing Scene Copy / paste is used to create a Scene from an existing Scene. Right-click the Scene to be copied



2 From Contextual menu select Copy



3



Right-click the Scenes branch



4



From Contextual menu select Paste



5



6



From Contextual menu select Properties



7



Specify a new name
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1



Instructor Notes:
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Right-click the new Scene



Another way to copy a Scene is to select a Scene in the tree and press the Create Scene icon.
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Editing Enhanced Scenes
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You will learn how to edit a scene and modify components’ properties



Instructor Notes:
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About Editing Enhanced Scenes General Scene Management Calling a Scene: Double click on the Scene to open Deleting Scenes: Open Contextual menu and delete the Scene Replacing the Scene Viewpoint : Modify the Viewpoint and click on the this icon
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Apply Selected Attributes of the Scene on the Assembly



Instructor Notes:
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Modifying the Enhanced Scene’s Viewpoint When You create a Scene the viewpoint you used at the moment of the scene creation, is the one you open when accessing the scene. You will learn here how to modify it



Double click on Scene



2



Copyright DASSAULT SYSTEMES



1



Instructor Notes:



Copyright DASSAULT SYSTEMES



Modify the current viewpoint (for example, using standard views)



When you enter the scene you get the previously saved viewpoint



3



Click on ‘Save Viewpoint’ icon



When you will access this scene this will be the viewpoint
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Applying a Scene on the Assembly This function is very useful when you have stored different states of an assembly and want to re-apply them on the assembly 1



Right-click the Scene you want to apply on the assembly



1 2



2



Click on “Apply Scene on Assembly”



In a similar way, you can perform the reverse of the above operation i.e apply an Assembly on Scene



Copyright DASSAULT SYSTEMES



1a



Right-click the Scene you want to apply assembly on it



1a



2a 2a



Click on “Apply Assembly on Scene”



Instructor Notes:
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Applying User defined attributes This function is very useful when you want to apply predetermined settings 1



Right-click on Scene whose attributes you want to apply on assembly



2



Select “Set User Defined Attributes”



3



Activate attributes which you want to apply Status will change to Lock



4



Right-click on Scene, go to Apply Scene on Assembly, Select Apply User Defined Attributes
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Attributes which are locked are applied on Assembly



Instructor Notes:
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Managing Components in Enhanced Scenes
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You will learn how to manage components and there properties in a Scene



Instructor Notes:
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About Components Management in Enhanced Scenes You will see how to use the Basic tools available in scenes Show / No Show Components By default the scene is the copy of the Main window, or the selected scene. You may want to swap some objects to show or no show Modify Color Properties You can modify the color, without modifying it in the main window Move Components This is the main interest of the scenes. You can try new positions, there and then apply them to the main assembly and check the result, by updating the different measures De-active Shape
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You can de-active shapes, without modifying their state in the main window



Instructor Notes:
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Hiding Components in Enhanced Scene Hide state of components can be set in a Scene. This does not effect the assembly. Access the Enhanced Scene



2



Select Components to No-Show



3



Click on Show/No-Show button
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1



Instructor Notes:
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Modifying Color Properties in Enhanced Scenes
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The color of components can be set in a Scene. This does not effect the assembly. 1



Double click on Enhanced Scene



2



Select Components to modify color



3



Open the Contextual Menu and Select Properties



Instructor Notes:
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4



Choose a Color in Graphic Tab



5



Click on OK to Confirm
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Moving Components with Compass in Enhanced Scene The position of components can be modified. This does not effect the assembly. 1



Drag and Drop the Compass on the object to be moved



2



Move the component by the compass



3



Move Back the Compass to its original position after use



The elements can be moved in the same way than in the main window.
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You can also use the Snap function to position the components in the Scene



Instructor Notes:
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Resetting Components Position in Enhanced Scenes The elements can be reset, using the main window as reference 1



Select the part to be reset



2



Click on the Reset Position icon



2
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State of the components outside the scene



State of the components in the Scene



Clicking on the Reset Position icon without selecting any component will reset all the components.



Instructor Notes:
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State of the components in the after resetting position in Scene



You can reset more than one component at a time by selecting with the mouse while holding the [CTRL] key [CTRL] key
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Creating Explode in Enhanced Scenes
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You will learn how to create explode view of assembly in the Scene



Instructor Notes:
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About the Explode Dialog Box Select in Depth : •‘One Level’ only the first level components of the product(s) will be exploded •‘All Level’ all the components of the product(s) will be exploded



Selected Products to be exploded



Select type of Explode: • ‘3D’ Product(s) are exploded in the space • 2D Products are exploded and placed in the same plane, parallel to the screen • ‘Constrained’ Products are exploded according to assembly constraints. Select fixed Product



3D



2D



Cursor representing level of Depth To navigate through in exploded Products. Example : levels of Explode 3x click
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2x click



Instructor Notes:
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Level 3 Level 2 Level 1 Level 0
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Exploding in an Enhanced Scene 1



Activate the desired Scene



2 Click on



3 Fill the Explode Dialog Box



Use the Compass to move components in scenes Click on OK to Confirm
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6



Instructor Notes:
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5



Move the Components



4 Click on “Apply”
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Creating Drafting Views Based On Scenes
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You will see how to create a drafting view based on a scene



Instructor Notes:
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What are Drafting Views Based on Scenes ? Scenes make it possible to have drafting views where components are in different states than the assembly. Scenes also avoid the need to reconstruct manually views as components are added, deleted, replaced, and moved in an assembly.
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Without Scenes it would be difficult to create a drafting sheet that shows the assembly in two different states (as shown below).



Instructor Notes:
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Scenes also avoid the need to reconstruct views (such as the exploded view shown below) when components are added, deleted, replaced, and moved in the assembly.
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Creating a Drafting View Based On a Scene Creating a drafting view based on a scene follows nearly the same steps as normally done when creating views. 1



Double-click the scene



2



Switch to the Drafting Workbench and select a isometric view creation icon.



3



Select the entire assembly



You can expand the tree and select a different node. Only selected node and it’s components will appear in the view.
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Do not use to hide components in a scene the Hide/Show tool ; use instead the Activate/Deactivate tool.



5



Click the drafting sheet to accept the view (as normally done when creating a view)



Instructor Notes:
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4



Select a reference plane
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Managing Scenes: Recap Exercise Connector Housing 15 min
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In this exercise you will create scenes that capture various states of the assembly and you will apply them to the assembly



Instructor Notes:
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To Sum Up ... This concludes the sub lesson on managing scenes, you should be able to demonstrate: Creating and editing enhanced scenes Managing components in enhanced scenes Creating exploded 3D view in a scene
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Creating drafting views based on scene



Instructor Notes:
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Product Structure Numbering
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You will learn how to associate numbers usable for drafting to the different parts of your assembly



Instructor Notes:
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What Is Product Structure Numbering? The Generate Numbering command allows you to associate numbers or letters to the parts which make up your product. Those numbers will also appear when creating balloons on Drawings generated from the assembly
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Created Number



Instructor Notes:
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Created Number appearing in a balloon
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Product Structure Numbering (1/2) The Generate Numbering command allows you to associate numbers or letters to the parts which make up your product. 1



Select the Generate Numbering icon



6a



The generated numbers appear in the properties dialog box (Product tab)



6b



The generated numbers also appear in the bill of Material



Created Number
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2



Select the root of the product



3



Select numbering mode



4



Select what you do with already existing numbers 5



Click on Ok



Instructor Notes:
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Product Structure Numbering (2/2) On a drawing generated from the product , when creating balloons on parts you will have by default the letter or number generated for the part in 3d. 7



9



8



Generate a Drawing from the 3d



Select balloons icon In Drafting Workbench



When selecting an edge for ballooning, you will get the whole part.Click it
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11



10



click on the sheet to place the balloon



Instructor Notes:
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You can change it but the default value inside the balloon is the number of the selected part. Click Ok to validate



Product Design



Generating Annotations You will see how to create several types of annotations in CATProduct files
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Introduction to Generating Annotations Weld Feature Annotations Text Annotations Flag Note Manipulating Annotations To Sum Up



Instructor Notes:
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Introduction to Generating Annotations Annotations are added to the assembly documents to denote additional information about a part or product. This additional information can be a brief description of the part, material used for the part, mating component, usage of the part, finish requirements, hardness requirements and much more. 3D Annotation Query Switch



In Assembly Design Workbench, you can add following three types of annotations : Weld Feature : A Weld Feature allows you to add weld symbols and notations.



Weld Feature



Text with Leader : A Text with Leader allows you to add a brief description of the part.
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Flag Note with Leader : A flag note allows you to add links to your document and then use them to jump to a variety of locations, for example to a marketing presentation, a text document or a HTML page on the intranet.



Flag Note Text with Leader



Weld Feature



You can add links to models, products and parts as well as to any constituent elements.



Instructor Notes:
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Text with Leader Flag Note



Product Design



Weld Feature Annotations
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You will learn how to add annotations concerning welding between components inside FD&T 3Dviews



Instructor Notes:
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What Are Weld Feature Annotations ?
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Weld Feature annotations show specifications for welding between several components. CATIA add them inside FD&T (Functional Dimensioning and Tolerancing) 3D views.



Instructor Notes:
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Creating a Weld Feature (1/2) You will see how to add a Weld feature annotation to annotate the parts which are to be welded together. 1



Click the Weld Feature icon



2



Select the edge of the component as shown
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This flag indicates the Welding is done on Working Site



3



Specify the various details in the Welding Creation dialog box.



4



When finished with specifications click on OK



Instructor Notes:
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This Symbol indicates the welding is all around the part



This switch will put the Main Welding indications up or under the center line to tell where the welding is (this side or the other) Type of Welding



Additional information about the Type



Length of Welding



Size of Welding



Indications about Welding on the other side



Welding Process



You can Import File about welding Process
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Creating a Weld Feature (2/2) Addition of Weld Feature annotation induces creation of a support plane for the annotation. Annotation Set is added in the specification tree. It contains two nodes – Views and Welds



Weld Node contains various Weld Feature annotations added in the model
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Weld Feature annotation is displayed in the model



Instructor Notes:
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Annotation Plane
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Text Annotations
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You will see how to add text annotations on your assembly



Instructor Notes:
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What Are Text Annotations ?
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Text annotations are text that you can see in the 3D view. You can edit and modify them when you want. Text annotations are associated with a geometric element of a component in the assembly.



The Text Annotation icon and the associate dialog box



Instructor Notes:
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Associated Features
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Creating Text Annotations When you create a text annotation, you implicitly use a FD&T view that will be created if not already existing Click on Text icon



1



2



Select a geometric element



3



Key Text



4



Validate
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Text Annotation



5



Text Annotation and supporting view are displayed in geometry and under annotation set in the specification tree. You can edit the annotation when you want by double clicking on it



Instructor Notes:
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Supporting View
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Flag Note
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You will see how to add flag notes on geometric elements of your assembly that will call other electronic files (hyperlink)



Instructor Notes:
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What Are Flag Notes ? You can add hyperlinks to your document and then use them to jump to a variety of locations, for example to a marketing presentation, a Microsoft Excel spreadsheet or a HTML page on the intranet. You can add hyperlinks to models, products and parts as well as to any constituent elements.
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Flag note tool



Dialog Box



Instructor Notes:
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Associated Features
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Creating Flag Note (1/2) When you create a flag note, you implicitly use a FD&T view that will be created if not already existing. 1



Click on Flag note icon. 3



1



2



Select a geometric element



3



Key text that will appear on flag



4



Click on Browse to select a file to link.



5



Double click on the file you want to attach.



4
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5



2



Instructor Notes:
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Creating Flag Note (2/2) When consulting the linked file, you implicitly launch the application that can read it. When you double click on the flag note (in the specification tree or in the 3D view), the dialog box is displayed.
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6



Supporting View



Flag Annotation



Instructor Notes:
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7



Thus you can edit the linked file by a double click or by the “Go to” button
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Manipulating Annotations
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You will see how to change annotation’s supporting view and how to change leader shapes. You will even see how to project annotation views on drafting.



Instructor Notes:
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What is Manipulating Annotations ? You can change the FD&T 3D view support of an annotation, and you can add or remove leader of annotation. You can even modify their symbol shape . We would like to replace this leader by another one snapping the right geometric element



Here the leader is connected to another geometric element and has a different symbol shape
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The annotation is not supported by the right 3D view



Instructor Notes:
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Here the annotation is differently oriented because supported by another FD&T 3D View.
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Changing Annotation Supporting View CATIA choose implicitly a supporting view when creating a Weld Planner but you may not be satisfied with this choice, so you can change it.



1



To change the supporting view, right click the annotation and select in contextual menu of annotation “Transfer to View/Annotation Plane”
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2



Instructor Notes:
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Select the new supporting View



3



The annotation is now supported by this view
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Manipulating Annotation Leaders (1/3) CATIA puts automatically a leader on your weld planner feature but you may not be satisfied with the anchor point. To delete a leader... Select the annotation
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1



Instructor Notes:
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2



Select “Remove Leader” in contextual menu of the yellow point



3



The leader has disappeared



Notice that if the Weld Planner feature has not any leader, the Weld process won’t appear either
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Manipulating Annotation Leaders (2/3)



To add a leader... Select “Add Leader” in contextual menu of the Weld Planner Feature
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1



Instructor Notes:
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2



Click the anchor point leader in the geometry



3



The new leader has appeared



Notice that only geometric elements involved in the annotation are selectable
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Manipulating Annotation Leaders (3/3) To define Symbol Shape of a leader... Select the weld planner feature



Copyright DASSAULT SYSTEMES



1



Instructor Notes:
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2



Select “Symbol Shape” in contextual menu of the yellow anchor …



… and choose symbol in its submenu



3



The leader has a new shape
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Projecting Annotation Views On a Drafting You can dispose of FD&T 3D views in CATDrawing files



In the Drafting Workbench, select “View From 3D”
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1



2



Select one of the 3D views in the specification tree or in 3D window



Instructor Notes:
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3



The View is now on the Drafting and displays annotations



Take care of having same Standards (ISO,ANSI) in 3D and 2D views otherwise you won’t be able to add a view from 3D (default Standard in 3D Views is ANSI).
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To Sum up … In this lesson you have learned how to generate and manipulate annotations You have seen how to add the three types of annotations to an assembly :
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Weld Annotations : to add weld symbols and notations Text with Leader : to additional information like name, property. Flag Note with Leader : to add links to jump to other documents, models, parts



Instructor Notes:
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Generating Reports You will see how to generate Bill of Material and Assembly Listing Reports.
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Introduction to Generating Reports Bill of Material Reports Assembly Listing Reports Generating Reports: Recap Exercise To Sum Up



Instructor Notes:
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Introduction to Generating Reports To have a more information about an assembly or product it will be useful to generate some reports. Bill Of Material can be created through CATIA V5; A way to manage the product structure is managing the BOM (Bill of Material).
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An Assembly Listing Report can also be created to “list” the components belonging to the CATProduct.



Instructor Notes:
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Bill Of Material Reports
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You will see how to generate Bill of Material Reports



Instructor Notes:
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What Are Bill Of Material Reports? Bill of Material Reports list all the components of an assembly. Components are listed by part number and the quantity of each part number is computed.



BOM with the components of the active assembly



One BOM for each sub-assembly
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Recap of leaf components from the active assembly and all sub-assemblies



Instructor Notes:



Deactivated and unloaded components are not listed in Bill Of Material.
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Generating Bill Of Material Reports
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Bill of Material Reports can be interactively generated and viewed. 1



Activate the assembly or sub-assembly to generate the BOM



2



Analyze + Bill of Material



Instructor Notes:
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Saving Bill Of Material Reports You can export the bill of material reports to several formats that can be viewed outside CATIA. To export the BOM click Save As ...
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1



Instructor Notes:
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2



Select a format and specify a file name
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Customizing Bill Of Material Reports
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You can customize the report of the BOM to display the properties of your choice and their order in the list. 1



Click on Define formats



2



Specify properties to be displayed 3



Arrange order of properties



Instructor Notes:
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Removing a Component From the BOM If you do not want to list in the BOM some products or components, you have to modify their properties. This assembly contains 3 products and 3 parts listed in the BOM
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Using the contextual menu select properties and deactivate “Visualize in the Bill Of Material”.



The products and parts paint in yellow have their properties modified. Only the part “Housing” and the product “Rollers” are listed.



Instructor Notes:
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Assembly Listing Reports
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You will see how to generate Assembly Listing Reports



Instructor Notes:
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What Are Assembly Listing Reports? Assembly Listing Reports list all the components of assemblies. Components are listed in a hierarchical or tree format.
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Hierarchy showing every component from the active assembly and all sub-assemblies



Instructor Notes:



Copyright DASSAULT SYSTEMES



Product Design



Generating Assembly Listing Reports You can generate an assembly listing reports that can be interactively generated and viewed.
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1



Activate the assembly for which the BOM is to be generated



2



Select “Bill of Material” in the Analyze menu



3



Select the Listing Report tab and then customize your report for your needs



Instructor Notes:
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Saving Assembly Listing Reports You can export the assembly listing reports to a text file.



1



Click on Save As...
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2



Instructor Notes:
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Specify a file name and folder. You can only save the list as a text file type.
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Customizing Assembly Listing Reports You can customize the Assembly listing report to display the properties of your choice and their order in the list.



1



Specify properties to be displayed



2



Arrange order of properties



3



Click the Refresh button 3
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Generating Reports: Recap Exercise Connector Assembly 15 min
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In this exercise you will generate two bill of material and an assembly reports concerning the Connector Assembly



Instructor Notes:
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To Sum Up This concludes the lesson on Generating Reports, you should be able to demonstrate: Generating and Managing the Bill of Material
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Generating the Assembly Listing Reports



Instructor Notes:
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To Sum Up In this lesson, you have seen is how to analyze assemblies, generate reports and assembly drawings. You can perform following analysis on assemblies : Measure Minimum Distance between components. Create and manage component in scenes: Scenes are used to create new positions and apply positions to the main product and create drawings. You can also modify color properties of components, Show / No Show components, move them and deactivate shapes using scenes. You can also create exploded views in scene. Compute clearances and clashes in between selected components. Computing clash results in detailed report indicating exactly what features are involved in the clash in order to make corrections.
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Generate Assembly drawings: You can generate assembly drawings from the product and create annotations in the drawings. You can create weld annotations, text with leader and flag with leader. Flags are used to add links to the document and jump to a various locations (URL, Power point presentation, Excel file, Word document). Generate Bill of Material and Listing Reports: Bill of Material report lists all the components in the assembly with part number and quantities. Listing report lists all the components of an assembly in the hierarchial form like a tree.



Instructor Notes:
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Product Design



Course Summary In the Product Design Expert Course you have seen how CATIA V5 helps you to : Manage Links between various documents of a product. Design assemblies in a collaborative workspace by using Contextual Design Publications Optimize the performance for large assemblies by: Managing representations and components of a product Using Visualization Mode
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Analyze assemblies by: Creating scenes and managing components in scene Creating sections Using assembly measure Add information in assembly drawings by: Using Product Structure Numbering and generating annotations Generating Bill of Material and Listing reports



Instructor Notes:
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CATIA Product Design Expert 

Sep 19, 2008 - CATIA Product Design Expert ... First load all the components from Companion into CATIA V5 and save them ... following assembly constraints:.










 








CATIA Product Design Expert .fr 

Sep 19, 2008 - The bottom face of the insert contextually rests ...... When creating an assembly hole, you will create a sketch that will belong to the part.










 








Product Design Expert CATIA V5 Training 

Sep 19, 2008 - Create and name the assembly as â€œConnector Assemblyâ€�. Add a sub-assembly â€œConnector Card assemblyâ€� and two instances of â€œConnector.










 








CATIA Part Design Expert 

Sep 19, 2008 - ... from the pulldown menu to see both brackets. â€¢ Modify Hole.1 in the Bracket-Right specification tree and change the radius from 15mm to.










 








CATIA V5 Mechanical Design Expert 

Manual coupling: Used when various sections do not have the same number of vertices. 6. Multi-Sections Solid using Relimitations: By clearing the Relimitation ...










 








CATIA V5 Mechanical Design Expert 

Aug 19, 2008 - You should view the student manual as a supplement to, not a replacement for, the ..... Ensure that there are no questions before moving on to the next step. ..... tricky situations in the parent-children relationship inside the part.










 








CATIA V5 Mechanical Design Expert - MAFIADOC.COM 

... the opportunity to apply and practice the material covered during the lecture ... They are brought together to understand the use of these methods and ... design tool that takes advantage of the easy- ... in Context and the Skeleton method.










 








CATIA FEM Solid - CATIA design 

Jan 19, 2009 - Right click on them, choose â€œDeactivateâ€�. â€¢ Click â€œRotation Mesher â€œ icon. â€¢ Select the tetrahedron filler mesh for the meshpart. â€¢ Select the ...










 








CATIA Mold Tooling Design 

Jan 19, 2009 - Select new Product in the specification tree (orange highlight) ... Page 5 ... Select in the dialog box the design table icon corresponding to ...










 








CATIA V5 Surface Design 

Aug 19, 2008 - Select this edge to be filleted and key in a 3mm radius value: 3.7 - You are going to create a multi-edge fillet on the previous surface: â€¢ Click on ...










 








CATIA Surface Design 

20 min. Modify spline control points. Modify a surface profile sketch. Modify a surface fillet radius. Button and Mouse Exercises. Topics covered: Mouse Exercises ...










 








CATIA Generative Shape Design 

Sep 19, 2008 - Create two Arcs of Radius 70 mm in Sketch.4 on YZ plane. Create a ...... manual coupling with definition of the coupling curve(s). Automatic ...










 








CATIA Tooling Design 

Jan 19, 2009 - CATIA Training .... been created in the specification tree in father sub-assembly ... required (no need for the complete Mold assembly).










 








CATIA Surface Design .fr 

Sep 19, 2008 - Present the different Companion documents available for additional information and the ..... operations in the tree structure) and a Geometrical Set (Wireframe ... use of a Geometrical Set is for creating logical organizational.










 








CATIA Surface Design 

Sep 19, 2008 - Students attending this course should be familiar with the CATIA V5 interface. .... and surfaces can be designed using the part or assembly.










 








CATIA Generative Shape Design 

Sep 19, 2008 - Recap Exercise: Advanced Wireframe Geometry. 48. Wireframe ... Recap Exercise: Adaptive Swept Surface. 103. Creating ...... Page 150 .... practices. Many times healing is used on parts imported from other CAD systems.










 








CATIA Generative Shape Design 

Sep 19, 2008 - CATIA Generative. Shape Design ...... constraint on the intersection computed by CATIA. ...... design surface parts in the context of an assembly.










 








CATIA Generative Sheetmetal Design 

Sep 19, 2008 - Casing Assembly Master Exercise. 1. Casing Assembly: Wall Creation Exercise. Objective: Upon completion you will have created the walls ...










 








CATIA Generative Shape Design 

Version 5 Release 19. September 2008 ... Table of Contents. 1. ... The bottom of the Specification Tree should now look like this: â€¢. 1.3 - Now, create a new ...










 








CATIA Generative Sheetmetal Design 

Sep 19, 2008 - 146. Recap Exercise for Sheet Metal Features. 150. Summary. 151 ...... The DXF file can be imported in CATIA as well as other CAD systems.










 








Part Design Expert 

Sep 19, 2008 - Step 4: Make the Boolean operations. 243 ...... shape using Boolean operations. 3. Trim the ...... 'Bottom Ring Slot Diameter' of type 'Length'.










 








Part Design Expert 

Sep 19, 2008 - -Design using Boolean operations. -Share Designs by ...... Boolean approach facilitates design of complex parts. 2. ...... CD placement ring.










 








CATIA Aerospace Sheet Metal Design 

Jan 19, 2009 - Select design table icon for the Bend Radius parameter .... â€œManual Complete Solveâ€�. â€¢ The check becomes green => the clearance distance is ...
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Lesson 1: Introduction to Generative Shape Design ... 'CATIA V5 for Surfaces' is to teach you how to build basic and advanced ... This course is designed using a process-based approach to training. ... You should view the student manual as a suppleme
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